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�  Mar 10, 2008 
 
 
The first part of this manual covers features that are common to the 
PowerAIM 120 and the AIM4170 antenna analyzers. Features that are 
specifically for the PowerAIM are covered in Appendix 11.     
In this manual, references to “AIM4170” apply also to the PowerAIM 120.   
 
The same program runs on both instruments. Special features for the 
PowerAIM are found under the “PowerAIM” tab on the menu bar. 
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    Highlights of this update: 
 

1. Custom calibration procedure for filters and transmission lines. 
2. Crystal measurement data can be saved in a file. 
3. Graphs can be plotted with special symbols. 
4. External control for integration with another program. 
5. Swap graphs. 
6. Line extension function to compensate for adapters and connectors. 
7. Legend to identify graph styles. 
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Quick Start 
 
Loading the Software: 
 
The AIM4170 software does not require a formal installation procedure. It does not 
interfere with any other programs or the registry on your computer.   
 
1) Create a folder or a subfolder on any convenient hard drive. 
For example, “C:\AntennaAnalyzer”. 
 
2) Insert the CD labeled “AIM 4170” in the CD drive. 
 
3) Copy all the files on the CD to the folder you just created for the antenna analyzer 
software and documentation. 
 
4) The file labeled “AIM_xxx.exe” is the executable file. It is ready to run without going 
through an installation process.  When later versions of the program are released, the 
number “_xxx” will be different. All versions of the antenna analyzer program can reside 
in the same folder at the same time, although separate folders can be used to keep the 
files organized. The older programs with the lower numbers will not interfere with the 
newest version, so they do not have to be deleted.  If there is any question about the 
performance of a new version, you can switch back immediately to an earlier version for 
a comparison.    
 
If you want to make a shortcut icon for your desktop, right click on the AIM_xxx.exe file  
and select “create shortcut” from the dropdown menu. Drag the shortcut to your desktop 
or task bar.  Right click on the icon to bring up the renaming option. 
 
When the files are loaded from a CD, they may be flagged as “read-only”.   In order for 
the calibration and initialization data files to be updated properly, the “read-only” flag 
must be cleared.  Highlight all the files in the folder by pressing control-A and then 
right-click to see the properties of the files. If the “read-only” property box has a 
checkmark, uncheck it and then click “Apply”.  This will remove the read-only flag on all 
the highlighted files.   None of the files in the folder need to be read-only. 
 
For the latest software version check: http://www.w5big.com/prog_update.htm 
For operating tips or to post your own ideas check: http://www.w5big.com/forum.htm  
 
HARDWARE CONNECTIONS:  
 
Plug in the DC power supply (8 to 12V at 500 ma recommended) and insert the connector 
into the jack on the rear panel of the analyzer.  Note: if a power supply is included with 
your AIM4170, it is for 120VAC only.  
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Press the power switch. The Green LED will blink a few times to indicate the version of 
software and then remain on continuously. The Red LED is on only when a measurement 
is in progress. 
 
To turn off the power, press the power switch again.  If the analyzer does not receive a 
command from the PC for 10 minutes, it will power down automatically if it is in the 
AutoPwrOff mode.  The AutoPwrOff mode can be turned on/off with a menu selection 
under the Setup tab at the top of the screen.   
 
The AIM4170 can be operated on battery power for remote operation with a laptop 
computer.  The current required is about 250ma while a measurement is in progress and 
about 50ma when idle.   
 
Batteries are not included with the AIM4170 but you can make a battery pack using any 
type of batteries you like.  There is room inside the case for a 9V battery and disconnect 
diodes are included so the battery and the AC power supply will not interfere with each 
other.  There is also a space for an optional resistor to use for trickle charging a battery, if 
desired.  The main power on/off switch controls the battery power too, so the leakage 
current is less than one microamp when the AIM4170 is turned off.  Refer to Appendix 6 
and the Application-Help file for more details 
 
When using the AIM4170 to test a mobile antenna on a motor vehicle, it is better to use a 
separate battery and not the 12V battery in the vehicle.  A 9V battery will power the unit 
for several hours or a small 12V gel cell (sealed lead acid) battery can be used for 
extended operating periods.  This avoids the problem of sneak paths through the ground 
between the DC power input and the antenna ground connection.  It will also help reduce 
measurement noise if it’s necessary to run the engine while taking data (such as to 
operate the air conditioner).  If it’s essential to get power for the AIM4170 from the 
vehicle, be sure to put 500 ma fuses in BOTH the +12V lead and the power ground 
lead.  A small voltage drop across the fuses will not affect the AIM4170 since the battery 
voltage is much more than the required minimum operating voltage.   The laptop 
computer being used should remain floating for the best measurement accuracy. 
 
When using the AIM4170 with a new antenna system, check the AC and DC voltage 
between the antenna ground and the ground used for the AIM4170 and the PC. This 
voltage should be less than 1V.  A balanced antenna should have a DC connection to 
ground through a balun or RF choke on one side (or both sides).  Of course there should 
always be a large resistor (or balun) connecting both leads of the antenna to a ground path 
in order to drain off static electricity.  
 
NOTE:  Before connecting a transmission line to the input of the AIM4170, 
be sure to momentarily short its pins together to drain off any static charge 
that may be present.  Also, be sure there is no DC voltage on the antenna. If 
there is DC, use a blocking capacitor between the AIM4170 and the antenna 
input. 
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Antennas and transmission lines can have enough static charge to damage sensitive 
electronic equipment. This can happen even when there is no rainstorm in the area. 
A strong wind can generate static charge. So can just flexing a coaxial cable by 
rolling it up or unrolling it, even if there is no antenna connected to it.   
 
An antenna or a component to be measured should not be connected or  
disconnected from the analyzer while a test is in progress.  A test is in progress when 
the RED LED is on.    
 
Be sure the maximum input voltage at the DC power connector does not 
exceed 15 volts. The minimum input voltage required is 6.0 volts.  
 
NOTE:   Low cost power supplies that plug in the wall are usually not regulated and their 
maximum output when no load is connected may be several volts higher than their rated 
output. Check the output voltage with no load to make sure it does not exceed 15 
volts.   
 
Power supplies that operate on a wide input voltage range such as 120V to 220V use a 
switching regulator. Evaluate the measurement results to see if noise from the power 
supply may be a problem.  For comparison, you can take some measurements while using 
a 9V battery and then with the AC power supply.   
 
PC INTERFACE CABLE:  
 
Connect one end of the RS232 cable to the antenna analyzer and the other end to COM1 
on your PC.  If you want to use a different COMM port, start the AIM4170 program and 
click on the Setup menu at the top of the screen. Then click on Enter Comm Port and 
enter the port number  that you want to use. This number will be saved in the setup file 
called AIM_xxx.ini.  
 
If you are connecting to the RS232 port with a new USB adapter, you will need the 
appropriate driver. If you purchased an adapter with your AIM, the CD you received has 
the driver file called: Y-105.  Another copy of this same driver is on a small CD 
enclosed in the cardboard package with the adapter.  
 
If you have a USB adapter that you have been using, it should be ready to run. 
To find the comm port automatically, click on Setup -> Find Comm Port.  This will scan 
from port 1 to 64 to locate the active serial port. It will take a few seconds to do the scan.  
Click Halt  to stop the scan. 
 
 For more information about setting up a USB/RS232 adapter, see Appendix 4. 
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Initial Operation:  
 
Launch the AIM_xxx.exe program.  You will see a graph similar to this: 
 

 
This is the last scan that was taken before the program was closed. Each time the 
program starts, it restores the previous scan. 

When the AIM4170 is present,  it must be turned on before the PC program is launched.   
If the PC program starts when the AIM4170 is not connected and powered up, the 
program will automatically enter the DEMO mode.   
 
For a quick test, connect the calibration resistor to the RF connector and click the SCAN 
button in the lower left corner of the screen. 
 
The Red LED will come on while the scan is in progress. A blue bar will move across the 
top of the graph as the scan progresses. 
 
You will see a set of traces (similar to the picture below).  The actual values are not 
important, but this shows the AIM4170 is functioning.   
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Scan using a 200 ohm resistor for a test load. 
 
The size of the graph can be specified in the Config File.  The ‘max graph width’ and 
‘max graph height’ parameters can be changed to make the graph compatible with 
smaller PC monitors.  Graph sizes down to 640x480 (and perhaps smaller) can be used. 
The ratio of the width to the height is not critical. When using a larger monitor, the graph 
size can be increased, if desired. 
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                                        Calibration 
 
The AIM4170 has no internal adjustments.  There are no trim pots or caps inside. All 
the calibration is done with the following software procedure.  
 
Click on the Setup menu and select Calibrate Analyzer. 
 

  
 
(The Custom Cal option is used for special applications and will be discussed later.) 
 
A message box will appear near the center of the screen, as shown below: 
 

 
 
Attach the BNC connector with an internal short circuit (this is included with the 
AIM4170, it’s labeled “short” and the color is green). 
 
If this shorting connector is not handy, then a piece of wire, like a resistor lead, can be 
used with good results too. 
 
After the short circuit is in place, click Continue. 
 
The program will run for a few seconds to take several readings of the short circuit . 
 
Sometimes when calibrating with a coax stub or an external filter connected to the AIM 
RF port, the impedance may appear to be significantly different from a short circuit at 
1MHz and a message will appear asking if this is a valid condition. If the connections are 
correct and you really do want to continue with the special external hardware hooked up, 
click YES. Otherwise, click NO to abort the cal procedure. Then after connecting the 
desired load, restart the calibration.  
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Then it will display a message box, shown below: 
 

 
 
Replace the short circuit with an open connector (red label) and then click Continue.  
 
The program will run for a few seconds to take several readings of the open circuit. 
 
 For the best accuracy, especially at VHF frequencies, use an open connector of the 
same type that is used for the short circuit . This allows the program to compensate for 
the stray capacitance of the connector itself. For example, 3 pF of stray capacitance due 
to a BNC connector represents a reactance of about 1K ohm at 50MHz which will appear 
to be in parallel with the load.  This will seriously affect readings at higher frequencies if 
it is not properly compensated. Therefore, the three calibration devices (open, short, 
resistor) should be carefully constructed so they have similar stray capacitance and 
inductance which will be cancelled out by the calibration procedure. 
 
NOTE: If you are using the UHF/BNC adapter (or another adapter) leave it on the 
output connector of the AIM4170 when calibrating the open circuit. In this way, the 
capacitance of the adapter itself will be included in the calibration process.   
 
For example, If you want to use a BNC-to-binding post adapter, calibrate the short circuit 
with a jumper wire across the binding posts. Then remove the wire and calibrate the 
open circuit condition with the adapter still attached. This procedure cancels the stray 
capacitance of the adapter and you can get accurate readings of discrete components 
attached to the binding posts. 
 
The calibration procedure can also cancel the effect of a short piece of coax that is used 
as a jumper to connect the AIM4170 to the load. In this case, the open, short and standard 
resistor are connected to the far end of the jumper.  Good results have been obtained with 
as much as two feet (60 cm) of  jumper coax. 
 
If the jumper is close to 1/4 of a wavelength long, the calibration data may not be 
accurate and a warning message is displayed. You can continue to cal but be sure to 
check the scan data for reasonable values under this condition.  If you’re sure the data is 
satisfactory, you can disable this warning message with a flag in the configuration file.
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After taking several readings of the open connector, the program will prompt for the 
standard resistor with a value between 50 ohms and 500 ohms.   This resistor should be 
mounted on a connector like those used during the open and short calibration steps. The 
exact value is not critical. Enter the value you measured with a digital ohmmeter and 
click Continue.  If you are using the cal resistor (yellow label) that is included with your 
AIM,  the number printed on it should be entered.  If you have a different cal standard, 
use that value. 
 
After reading the standard resistor,  the Red LED goes off and the prompt for a comment 
appears. This optional comment will be saved with the cal file and can be read later in the 
Status window.  It can also be viewed in the cal file itself with any text editor (such as 
Notepad).  After entering the comment a request for the calibration data file name 
appears.  A separate folder can be used for cal files, if  desired. 
 

 
 
Enter the name of the calibration file and click “Save”.  There is no restriction on the 
name of the cal data file. Its extension is automatically set to .acal (“analyzer cal”).  Any 
of these cal files can be recalled latter using the menu option “File” �  Load Cal File. 
 
Then the cal complete message box is displayed as shown below:  
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Click OK to continue. 
 
Each time the AIM4170 program starts, the last calibration file that was used will be read 
to restore the cal data.  
 
 Since there are no adjustments that have to be made inside the case, the calibration is 
very stable. 
  
This completes the calibration procedure.  Now you are ready to begin testing your 
antenna. 
   
NOTE:  Before connecting a transmission line to the input of the AIM4170, 
be sure to momentarily short its pins together to drain off any static charge 
that may be present.  Also, be sure there is no DC voltage on the antenna. If 
there is DC, use a blocking capacitor between the AIM4170 and the antenna 
input. 
 
Antennas and transmission lines can have enough static charge to damage sensitive 
electronic equipment. This can happen even when there is no rainstorm in the area. 
A strong wind can generate static charge. So can just flexing a coaxial cable by 
rolling it up or unrolling it, even if there is no antenna connected to it.   
 
An antenna or a component to be measured should not be connected or 
disconnected from the analyzer while a test is in progress.  A test is in progress when 
the RED LED is on.    
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Colors 

The color of each trace corresponds to the color of the label at the top of the Y-axis. 
SWR is RED and this scale is on the left side of the graph. On the right side the 
magnitude of the impedance is the inside scale and the trace is GREEN.  The reactance 
is in YELLOW, also on the inside scale. Reactance and impedance use the same scale. 
Reactance can be positive (inductive) or negative (capacitive). The phase angle of the 
load impedance is plotted in MAGENTA and this scale is on the outside of the right hand 
vertical axis.  These colors can be changed in the configuration (*.cfg) file if desired. 

The width of the traces can be specified in the config file. The default width is “2”. For 
some situations, such as presentation slides, a wider line may be desired. A separate 
config file can be set up so you can switch between display options quickly with the 
Files->Load config file menu. 
 
Each trace can be plotted in a different style to make it easier to visualize. This is 
particularly helpful when graphs are printed in black and white. The menu is shown 
below: 
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This example shows some of the styles: 
 

 
When a new style is selected, the graph is redrawn to show its effect. The styles are saved 
in the *.ini file.  The style only applies to the image on the screen, the raw data is not 
affected.  The traces for a “rescan” are plotted with plain lines. 
 
A legend showing the graph styles presently in effect can be displayed by clicking 
“Legend” on the Graph Styles sub-menu.  This will appear in the lower right corner of 
the graph. 
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Commands 

The most common commands use the buttons along the bottom edge of the screen: 

SCAN  (S)– Starts the frequency scan between the specified limits: Start_freq to the 
End_freq. (see Limits button below.)  Each time the scan button is clicked, the graph is 
cleared and the new scan data replaces the previous data in memory. 

RESCAN (R) – A new scan is started but the graph is not cleared. This makes it easy to 
see the before and after effects of changes to an antenna (or any discrete component 
being measured).  The new data replaces the previous data in memory but both graphs 
can be viewed simultaneously.  RESCAN can also be used to overlay new data on top of 
a scan that was loaded from a data file. See “File -> Load” below. 

RECYCLE – Scanning is repeated over and over until the RECYCLE or the HALT 
button is clicked.  This makes it possible to continuously view the results while adjusting 
an antenna or tuning a stub.  The resonant frequency is displayed above the graph and it’s 
updated after each scan during recycle.  The scan limits can be adjusted to narrow the 
scan range for a faster update rate. 

A flag in the config file determines if the graph is erased before each scan. The default is 
to not erase. 

 POINT DATA (D)  - Measure the impedance at a specified frequency.  The 
measurement can be a single-shot reading or repeated about 2 times per second until the 
point data  window is closed.  Click the “Tune” button to start the repetitive mode.   As 
it’s name implies, the Tune mode has been found to be very useful when adjusting an 
antenna tuner.  This avoids stressing the power amplifier when the antenna is mismatched 
and it eliminates interference to others since the AIM4170 output power is less than 20 
microwatts. 

In the tune mode, a set of buttons appear in the data window to allow the test frequency 
to be incremented or decremented.   The point data window display is shown below.   

While in Tune Mode a tone related to the SWR can be played through the PC speaker to 
assist in making adjustments without watching the monitor. Click the button labeled 
“Tone On” to start the tone. The parameters of the tone can be changed using the setup 
routine called “SWR Tone” under the Setup tab on the main menu at the top of the 
screen.  

SWR, Zmag and Theta can be sounded out in Morse code. See the Setup menu to enable 
this function. 
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                                      Point Data Window             

LIMITS  (L)– When this button is clicked, a dialog box, as shown below, pops up for 
entering the start and stop frequencies and the size of the frequency increment (step) 
between measurement points. The start and stop frequencies range from 0.1MHz to 
170MHz for the AIM4170. 

 

 For example, to scan the 40-meter band, you might enter 6.9MHz for the Start 
frequency, 7.4MHz for the Stop frequency and 0.01MHz for the frequency Step (the 
spacing between measured points). This would result in a scan of 50 points across the 
band.  The maximum number of scan points is 1000 and the minimum number is 5.  
Frequency values can be in KHz instead of MHz if the number is followed by a K  or k. 

You can also enter a number greater than 20 in the Step box and the scan will use that 
many data points.  (A step size equal to or greater than 20 is interpreted as a number of 
points rather than a frequency step in MHz.)   If the number in the Step box is followed 
by a percent sign “%”, the step size will be that percentage of the total scan width. 
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Note that when using the cursor to read out numeric data (discussed in detail later), the 
displayed values are interpolated between the measured values. Therefore, in some cases 
it may be desirable to use a larger frequency step for a faster scan rate.  You can still 
read the parametric values at intermediate frequencies with the cursor.  The scan rate is 
about 15 to 25 points per second, depending on the speed of the PC and the value of 
averaging that is used. The program can be run on older computers with Windows 95 but 
the scan rate may be slower. 

SCALES -  When this button is clicked, a dialog box pops up for entering the full-scale 
values for:  SWR, Zmag (impedance magnitude), Theta (degrees), and Return Loss (db).  

 

 If the actual measured value is off the scale (flat line at the top of the graph), the value 
readout by the cursor is still valid since it uses the raw data stored in memory.  For 
example, you can set the Zmag scale to 500 ohms in order to see fine details but if the 
impedance actually goes up to 1600 ohms at some frequencies, the cursor can still read 
the true value and display it in the data window. 

If you select a new scale factor, the last data scan will be replotted using that scale. 

 

 

 



 PowerAIM 120                                                                                  page 17 

SMITH  – A window is 
displayed with a Smith chart 
showing a plot of the reflection 
coefficient versus frequency. As 
the cursor is moved with the 
mouse over the original linear 
plot, a marker dot is displayed 
at the corresponding point on 
the Smith chart and the relevant 
data is displayed in this 
window. 

Note, the point that is 
highlighted on the Smith chart 
corresponds to the frequency on 
the horizontal frequency axis of 
the original graph. This graph is 
under the Smith chart and the 
horizontal axis may not be 
completely visible, but the 
actual frequency that the cursor 
is pointing to is displayed on 
the Smith chart itself. 

 

A green circle of constant SWR 
will be displayed when the 
SWR Ruler (see the Setup 
menu) is set to a value greater 
than 1.0 

A red dot marks the start of the 
Smith chart trace. 

 [The center of the Smith chart 
corresponds to 73 ohms in this 
example. The Zo value is 
specified using the Setup 
Menu.] 

 

 

COMMENT  – A dialog box pops up for you to enter a comment that will be displayed at 
the bottom of the graph. This is very useful for documenting the test conditions. This 
comment will appear in a screen capture or a screen print and it will be saved in the raw 
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data file on disk if this scan is saved.  Comments can also be added to a graph or a 
calibration file before it’s saved. 

HALT  - While the scan is in progress, you can stop it by clicking this button. This is 
different from the QUIT button (shown below).  

QUIT  – This stops the program, saves the setup conditions (limits, scales, etc) and exits 
back to the Windows OS.  When the program is launched again, the setup conditions and 
calibration data will be restored automatically.  
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                                 Commands on the menu bar at the top of the screen: 

FILE :  

   Load Graph-- 

 

Load a raw data file from a previous scan. After this file is 
loaded, its data is just like the original scan. The cursor can be 
used to read out the numeric values.  

When a data file is being displayed, the name of the file appears 
at the top of the graph.   

After a graph is loaded, a new scan can be done and 
superimposed on top of the old data by clicking Rescan.  This is 
useful for comparing before and after conditions when 
adjustments are made or when there may be a  long term change 
in a component or an antenna. For example, you can see if your 
antenna is the same today as it was last week before the 
windstorm. 

  Save Graph --  Save the raw data for the last scan that was done. If you clicked 
the RESCAN button, the data that will be saved is for the rescan. 
Even though the earlier scan is being displayed on the graph, its 
raw data was replaced in memory by the new data corresponding 
to last rescan command.  The raw data is saved in a file with the 
extension .scn. Another file is created with the same name and the 
extension .csv. The .csv file has the same data in a format that can 
be read into a spreadsheet. The format of this file is shown in 
Appendix 5. 

You can enter an optional comment when the graph is saved. 

Swap Graphs --  Swap back and forth between the present scan and the previous 
scan.  This function can be disabled by setting the “autoscansave” 
flag in the config file to zero (default is enabled). 

Swap can also be done by pressing either the up or the down 
arrow key. 

Save Image Bitmap Save the current graph image to a file in the .bmp format. If you 
just want to put the image on the clipboard to paste it into a 
document or another program,  press Alt-PrintScreen instead of 
this function. Then paste it into another application using 
Control-V.   

Print --  Print the graph on the system printer.  Before printing in black 
and white, you can change the graph display styles to highlight 
each trace.  This option is under the Setup menu. 
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each trace.  This option is under the Setup menu. 

Load Calibration --  Load a calibration data file for a particular test setup or adapter. 
These files have the .acal extension. 

Load Config -- Any of several configuration files can be loaded. A selection 
window will show all the files in this folder with the .cfg 
extension. 

             Quit --  Stop the program and exit.  
This is the same as the QUIT button at the bottom of the screen. 

FUNCTIONS:   

Measure Cable -- 

 

This command is used to measure several parameters related to 
the transmission line.  A message box pops up to prompt that the 
cable should be either open or shorted at the far end for these 
tests to be valid.  After this is ready, click OK to continue.   

Other dialog boxes prompt for the velocity factor and the length 
of the cable, if known. If the length is entered as Zero, the length 
will be determined using the velocity factor that was entered. If 
the length is non-zero, the length is assumed to be accurate and 
the velocity factor will be determined. 

Distance to Fault -- Measure the distance to a cable open or short. This can also be 
used to measure the ¼ wave length frequency of  tuning stubs. 
There is more information about tuning stubs in the on-line help 
file. 

Refer to Antenna -- The impedance readings are transformed to be equivalent to 
readings directly at the antenna terminals.  This procedure does 
not require disconnecting the transmission line from the antenna 
if you know the parameters of the coax. 

This should not be used if the transmission line is made up of 
several different kinds of line, such as, coax cable plus ladder 
line. 

For complex transmission lines, the Custom Cal procedure 
should be used.  Custom Cal takes the place of what used to be 
called “Ref to Antenna, Method A”.  This new procedure is more 
accurate and more versatile. It’s discussed later in this manual.   

Constant Freq --  Output a constant frequency that can be used as a test signal. 
Initial frequency accuracy is +/-30ppm. At 1MHz, the output  
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amplitude into 50 ohms is about 25 to 30mV-rms (-18 dBm) and 
somewhat less at higher frequencies. 

Band Scan -- (This feature is available on the AIM4170). Scan a band 
(particularly the AM broadcast band) to look for strong signals 
that may interfere with antenna measurements. The scan start/stop 
limits are set using the same LIMITS button that is used for an 
impedance scan.  The maximum scan range is 10MHz. The 
maximum frequency step is 2KHz, but a smaller step can be 
specified when the limits are set. The recommended maximum 
amplitude limit for an external signal is indicated by a red line, 
which corresponds to approximately 150mv peak. (This level is 
not precisely calibrated.) Signals above this limit may result in 
less accurate impedance readings. It is not a rigidly fixed limit 
and in some cases, impedance readings may still be sufficiently 
accurate when signals above the red line are present. 

Measure Crystal -- Measure the parameters of a quartz crystal automatically.     
 Details are in a later section.  The crystal data can be saved in a 
file that can be imported to a spreadsheet program, such as Excel. 

¼ Wave Stub -- Adjust a coax line to be 1/4 wavelength at a given frequency. The 
target frequency and the initial length (in feet) of the coax are 
entered in the dialog box. Then the graph runs in recycle mode 
and displays the amount of the line that needs to be cut off 
("Excess Length") to reach the target frequency. A vertical red 
line on the graph highlights the target frequency. The magenta 
colored phase plot crosses the horizontal axis at the quarter wave 
frequency. There is more information in the Applications file 
under the Help menu. 

Q Measurement – 

 

This is used to measure the Q of  resonant circuits.  First, do a 
scan with the limits set to include the resonant frequency and 
most of the response on either side of the resonant frequency. The 
step size is not critical but Q may change slightly with different 
step sizes. Experiment to see what is appropriate for your 
application. The resonant frequency does not have to be in the 
center of the graph.  

Antenna Bandwidth- The bandwidth of an antenna at an SWR set by the SWR ruler is 
determined.  First, enter the SWR ruler value with the Setup 
Menu. Then position the cursor near the valley of the SWR curve 
and click “Antenna Bandwidth”. The bandwidth and high/low 
frequencies will be displayed in a message box.  Vertical lines 
will highlight the bandwidth region.  For a multiband antenna, the 
bandwidth at each resonant frequency can be read by moving the 
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cursor. The cursor does not have to be exactly at the minimum 
SWR point.  The bandwidth limits will be highlighted with 
vertical lines. 

After positioning the cursor near the desired point, press the left 
mouse button to freeze the AIM cursor while moving to the 
bandwidth selection button on the Function menu. 

CALIBRATE:  

     Analyzer-- Calibrate the AIM4170 using open circuit, short circuit and 
resistive load conditions. The calibration data is saved in a disk 
file that’s read each time the program is started. 

An optional comment can saved with each cal file. The comment 
for the cal file presently in use can be seen in the Help->Status 
window. 

  Custom Cal --  The start, stop and delta frequency values can be user specified.  
The regular short, open & resistor loads are used. Long 
transmissions lines of any type can be calibrated at the far end so 
impedance data is then referred  to the antenna terminals. It can 
also be used to calibrate out the effects of filters in the line.  

After a transmission line or filter is calibrated, the start, stop and 
step frequencies can be changed as long as they are within the 
original custom cal limits. 

 SETUP:   

Plot Parameters -- Select the parameters that are plotted during a scan. The optional 
parameters are: SWR or reflection coefficient, Return Loss, 
Impedance Magnitude, Series Load Circuit or Parallel Load 
Circuit, Theta (phase angle).  The last scan data will be replotted 
with the new parameters. 

Graph Styles -- A different style for plotting each trace can be specified to make 
the traces more distinctive.  This is especially helpful when the 
graph will be printed in black and white.  For examples of the 
styles, refer to the section of the manual above called “Colors”. 

SWR Ruler -- A dashed horizontal line can be placed on the graph to help 
visualize when the SWR trace crosses a specified value.  To turn 
this line off, enter a value of zero. 

This value is used when finding the antenna bandwidth. 
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The ruler value corresponds to the green circle plotted on the 
Smith chart. 

Enter Zo -- 

 

Enter the nominal impedance of the transmission line. This is 
used  to calculate the SWR.  This is usually a real number, but a 
complex number can be entered with the imaginary part denoted 
by “i” or “ j ”. 

Average Readings- Each data point is obtained by averaging four or more ADC  
 readings to reduce the effect of measurement noise. When  
 this option is selected, “AVG =N” appears in red in the  
 upper right corner of the graph.  N is the number of readings 
being averaged and is between 4 and 16. 

 

Smoothing -- Smooth data by averaging a number of scans. This is a running 
average and will continue until it’s turned off  (by entering zero) 
or until new scan limits are entered.  While smoothing is on, be 
sure not to change the load.  For the smoothing to be effective, 
the load must be constant during the averaging process. 

Trend --  Plot a trend line based on N data points. This runs faster than 
averaging but it may cause some flattening of sharp peaks.  
Values of 2 to 5 are usually enough to be effective. Averaging, 
smoothing and trend are mathematically different.  In a 
particular situation, one may give better results.   

The online Application Note under the Help tab has more 
information and some graphs showing the effect of these options. 

Enter Comm Port --  Enter the RS232 port used for communication. 
Port values can be 1 to 65K. This is saved in the initialization file  
that’s read each time the program is started. 

Find Comm Port --  Automatically scan from comm port 1 to port 64 to find the one 
that is available.  This is useful with USB adapters since it isn’t 
always easy to tell which comm port they are assigned to. 

Morse --  Three values can be sounded out: 

   Sxx.xx= SWR,   Zxx.xx=Zmag,  Txx.xx=Theta. 

 The decimal point is coded as “R”.  This is active when  
 the “Measure Point” function is used (see above).  Morse output 
is controlled by the “Morse” item under the Setup menu. 
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AutoPwrOff This button enables/disables the automatic power down feature of  
 the analyzer.  The enable/disable flag is saved in the analyzer  
 initialization data when you exit from the program (QUIT) and  
 restored each time the program is started again.  The green LED  
 on the front panel of the analyzer blinks when this command is 
executed. The timeout delay is 10 minutes. 

 If you never use batteries, you may want to leave this feature 
turned off (the PC default condition).   

SWR Tone --  While in the Point Data  “Tune Mode” a tone related to the 
SWR can be output through the PC speaker. Lower pitch tones 
indicate lower SWR values. There are three parameters that 
control the characteristics of the tone:  

1. Min Tone – a value from 1 to 50 determines the pitch for 
            SWR=1.0.  This value is typically 1. 

2. Max Tone – a value between 10 and 60 that determines 
           the pitch for the highest value of SWR.  
           This value is typically 50. 

3. Max SWR – the highest SWR that will cause a change  
           in the pitch. SWR values higher than this generate 
           a constant pitch.  This value is typically 10. 

BANDS:  

Highlight -- Highlight the frequency bands, such as the ham bands or AM or 
FM radio bands. These frequencies are specified in the 
configuration file (*.cfg). The start/stop limits do not have to be 
the actual amateur band limits.  The highlight color can also be 
specified in the config file.  

The name of the band can also be user specified to be more 
descriptive. Refer to comments in the config file.  The AM radio 
config file has examples showing the names of each station.  

160..2 meters Click on the desired band to set the start/stop scan limits and the  
frequency step between measurement points.  These limits can be 
changed in the configuration file. 

Band A..D User specified band limits. Same as above. 
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UTILITIES:  

L-C Matching 
Networks by WY2U 

This program which is available on the web takes the impedance 
data (R and X) that is measured at the input end of the 
transmission line and calculates the L-C network required to 
transform it to the correct impedance (for example, 50 ohms) to 
match the transmitter. This can be used when designing a tuner to 
find the components to match an antenna over the desired 
frequency range. 

When you click on this link, your computer must be connected to 
the internet. You may have to authorize the connection if you 
have a firewall program. 

ZPlots by AC6LA This program uses the data saved in the .csv file (by "File Save") 
to plot graphs for presentations. It features plot parameter 
selection and zoom capability.  It can plot parameters that were 
not included in the original AIM plot and the plot range can be a 
subrange of the original data. 

When you click on this link, your computer must be connected to 
the internet. You may have to authorize the connection if you 
have a firewall program.  You can download the Zplots program 
to your computer and then run it off-line.  

HELP:   

Help -- A help file pops up in the local browser. This is in html format 
and can be edited by the user if desired. The file name is 
“help_xx.htm”. 

Applications --  Information about particular applications with the AIM. This is in 
html format and can be edited by the user if desired. The file 
name is “applications_xx.htm”. 

Edit Config File -- The config file is opened in a text editor for making changes to 
parameters. After saving the file, be sure to close the AIM 
program and restart it to load the new config file.  

Status --  The status window shows the value of some variables and the 
current path names for files.  When Custom Cal is being used, the 
start, stop, & step parameters are displayed. 

About -- The present version of the programs in the PC and the controller 
are displayed.  The url of the W5BIG website is also displayed. 
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are displayed.  The url of the W5BIG website is also displayed. 
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                                                          Data Display 

After a scan (or after loading a file from disk), the mouse can move a cursor along the 
frequency axis and the numeric data for several parameters will be displayed 
continuously in a data window on the right side of the screen.   An example is shown 
below: 

 

The light cyan vertical line is the cursor. It moves with the mouse whenever the mouse 
pointer is inside the graph area. In this example, the frequency is 7.4477 MHz. The 
frequency changes in 1-pixel increments due to the mouse resolution, so some specific 
frequencies may not be displayable.  The data is interpolated between the actual data 
points that were recorded during the scan. The cursor can also be moved in small 
increments using the Left/Right Arrow Keys on the keyboard.  

 Normally the cursor moves whenever the mouse pointer is inside the graph area.  The 
cursor movement can be stopped by pressing the left mouse button. This makes it easier 
to select items on the menu without disturbing the data being displayed on the right side 
of the graph.  The action of enabling/disabling the cursor with the left mouse button can 
be reversed with a flag in the config file. 

Data in the window shows the characteristic impedance, Zo, has been specified to be 50 
ohms. The SWR at 7.4477 MHz is 21.532, Zmag=35.239 ohms, and Theta= -84.352 
degrees.  
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Parameter values for both a series and a parallel equivalent circuit are shown as Rs, Ls 
(series circuit) and Rp, Lp (parallel circuit).  Note that when the phase angle, Theta, is 
negative, the equivalent components, Ls and Lp, change to Cs and Cp automatically.  

At the top of the graph in the main window, up to five resonant frequencies of the 
antenna are displayed. These are the frequencies where the phase angle passes through 
zero.   

The names of the calibration and configuration files being used are shown in the lower 
right corner of the data window. The color used to display these file names can be 
selected in the configuration file. 
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                                           Custom Calibration 

 

This specialized calibration procedure is useful for situations involving filters or long 
cables.  For more routine work with physically small sockets, adapters, or short cables, 
the Standard Calibration procedure can be used.  

This calibration technique allows the measurement reference point to be moved from the 
RF connector on the front panel to the end of a transmission line and/or a filter.  This has 
the advantage (compared to the standard cal procedure) of canceling the effect of 
complex transmission lines and filters so the data at the antenna can be determined more 
accurately.  The custom cal routine can be used to calibrate long transmission lines or a 
relatively short line that may be used for an interconnection in a lab setup.  This 
calibration process may take longer when a small delta-freq is used, but the actual scan 
rate is essentially the same using either standard or custom cal data. 

The user specifies the start, stop and delta frequency values for the calibration. 
Typically the delta frequency will be much less than 1MHz to take advantage of the 
improved accuracy when a complex circuit is connected between the RF connector and 
the measurement point.  Note: the standard calibration procedure takes cal data at 1MHz 
increments. 

The open, short and resistor loads are used.  The resistor value is not critical as long as 
it is accurately known.  The same resistor that is used for the standard cal procedure can 
used if an appropriate connector is available. When adapters are used, be sure to be 
consistent so that all three loads have the same capacitance and inductance.  For the open 
cal load, be sure to use an actual open connector. If the open cal load is not attached to 
the test connector, the stray capacity will not be properly calibrated.   For a BNC 
connector, this represents an error of approximately 3 to 4 pf. 

Click Calibrate -> Custom Cal and the parameter entry dialog box will open. 

By default, data entries are in MHz but if a number is followed by a K or k then the 
number will be interpreted as KHz. 

After the start, stop and delta limits are entered, there will be prompts to attach the short, 
open and resistor loads. Note that this routine does not check the value of the load (like 
the standard cal routine does),  so be careful to attach the appropriate one. After the 
calibration is complete, there is a prompt for an optional comment to be included with the 
cal data file. Then the name of the data file is entered. The name can be anything, but you 
may want to make the custom cal files distinctive from the standard cal files so it’s easy 
to tell them apart.  After calibration, a scan is done automatically (without plotting the 
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data) to see if the custom cal data is likely to be accurate enough for this particular setup.  
When the external circuit has rapid changes in phase (such as a filter), the custom delta 
freq has to be small enough to include data during the phase transitions. In some cases it 
may be necessary to use a delta as small as 1KHz. Up to 1000 cal points can be used. 

If warning message is displayed, the cal data may still be ok in the frequency range of 
interest.  The overall results should be evaluated with known loads, such as resistors with 
good RF characteristics. 

When a custom cal file is being used, the words “Custom Cal” will appear in red above 
the graph.  The scan start/stop and delta limits can be changed without having to do 
the custom cal again. This is a significant improvement from the previous Ref To Antenna 
Method A, which limited the scan to the original cable calibration limits. 

The comment that is included in the current cal file can be viewed by clicking Help -> 
Status.  The status window also shows the start, stop and delta parameters used for this 
custom cal file.  If a custom cal file is not being used, these data do not appear in the 
status window. 

The effectiveness of the custom cal procedure can be seen in the following examples. For 
this series of tests, a transmission line made up of two different kinds of coax was used: 

 
The high pass filter cuts off below 1.8MHz. It’s a Broadcast Band High Pass Filter 
from Array Solutions. (see their website for more information). This is very useful for 
rejecting local broadcast stations while tuning a 160 meter antenna. Inserting this filter 
will normally preserve the SWR readings around 160 meters but the impedance and 
phase angle may be changed. By calibrating at the far end of the filter,  The AIM can then 
transform the antenna data and significantly reduce the distortion caused by the filter. 
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The figure above shows a scan using the standard calibration method when the 
composite transmission line above is terminated with 50 ohms. This scan is highlighted 
with dots along each of the three traces: SWR, Zmag, and Theta.  The SWR shows some 
variation. The phase angle is off about 15 degrees at 1.95MHz. 

Then a scan was done using custom calibration data obtained at the end of the 
transmission line.  The new data is plotted with plain lines. Now the data is flat, 
indicating a nearly ideal 50 ohm termination. The phase angle is essentially zero; it lies 
on the x-axis so it’s not easy to see. 

  



 PowerAIM 120                                                                                  page 32 

 

The figure above shows the results when using an LC parallel turned circuit for a load. 
One scan was taken with the LC circuit connected directly  to the AIM’s RF connector 
using standard cal data. 

Then the LC circuit was moved to the end of the composite transmission line (shown 
previously) and another scan was done with the custom cal data.  When the two scans are 
overlaid, they are very close to each other. This before and after comparison was done by 
loading a new cal data file without changing the scan limits. Then click Rescan and the 
new scan overlay the original data.  The same type of comparison can also be done by 
loading a stored graph file and clicking rescan. 
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This scan shows the effect of a High Pass Filter that has high attention in the AM radio 
broadcast band. It is very effective in reducing interference picked up on a 160 meter 
antenna. The filter’s cutoff frequency is about 1.6 MHz.  To cancel the effect of the filter 
in the 160 meter band (1.8 to 2.0 MHz), the custom calibration procedure can be used.  

Below 1.6MHz, the cal data is noisy due to the attenuation through the filter. This is 
because the instrument sees essentially the same thing when any of the calibration loads 
are attached, so the compensation data is not consistent with the specific load. Above 
1.6MHz the signal through the high pass filter is normal, with low attenuation, and the 
calibration is accurate. The 50 ohm load read accurately in the frequency range of 
interest, 1.8 to 2 MHz.  

When using new filters or baluns that may have limited bandwidths be sure to 
evaluate the results using loads with known characteristics before advancing to the 
antenna itself.  
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                       Data Referred to Antenna 

Sometimes it is desirable to know the impedance right at the antenna terminals.  The most 
accurate method uses the Custom Calibration procedure discussed previously. In some 
cases it may be impractical to disconnect the coax from the antenna feed point so another 
procedure is available that only requires data from the manufacturer’s spec sheet.  

This method of transforming the data to the antenna can be used when the properties of 
the transmission line (Zo, length, loss and velocity factor) are accurately known.   This 
does not require disconnecting the transmission line from the antenna. It should only be 
used for transmission lines that employ a single type of coax. 

To select this feature, click Functions -> 
Refer to Antenna.  

Then enter the transmission line data in the 
dialog box. 

 

The length and velocity factor are combined to find the effective electrical length. 
Rather than trying to measure the physical length of the transmission line and estimate its 
velocity factor (which may vary from one roll of coax to another), you can measure the 
electrical length directly using the AIM4170.  Put a short circuit  across the antenna 
terminals (or disconnect the coax from the antenna) and scan to find the first point where 
the phase angle is zero. This is listed at the top of the graph as the first resonant freq, F1.   
This frequency corresponds to one-quarter of a wavelength, so the electrical length of 
the line is: 

    Electrical_length =  0.25*(299.8/F1)  meters 

                                 = 0.25*(984/F1)  feet 

This corresponds to the physical length of the coax divided by its velocity factor. The 
electrical length is longer than the physical length since the velocity factor is less than 
one.  Radio waves only care about the electrical length.  When entering the cable 
parameters, if you know the electrical length (by measuring F1 above), the top line can be 
a close “estimate” of the physical length and the velocity factor is the electrical length 
that was accurately measured, divided by this “estimate”.  For example, when I installed 
the antenna did I use 120 feet or 125 feet of coax?  Rather than trying to measure the 
length of the coax again, estimate its length as 125 feet.  Assuming the electrical length 
was measured to be 185 feet, the velocity factor would be 125/185 = 0.6757.  
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Alternatively, if you know the velocity factor, calculate the physical length by 
multiplying the velocity factor times the electrical length. 

The cable loss is usually given in terms of  “dB per 100 feet” on data sheets.  Enter the 
value of loss for 1MHz, if it’s listed.  If you’re interested in higher frequency bands and 
want a bit more accuracy, pick a frequency close to your region of interest and divide the 
loss at this frequency by the square root of the frequency in MHz.  

 For example, if the loss at 10MHz is 1.5dB/100feet, enter 1.5/SquareRoot(10) = 0.47 
dB/100 feet for the loss.  This attenuation value is close to the value at 1MHz.  You can 
enter loss as either a positive or a negative number, it doesn’t matter. 

 When calculating loss, the physical length of the cable is used.  Although the physical 
length of the coax may not be known with great accuracy, the loss has a secondary effect 
and it’s not as critical as the electrical length. Using 120 feet or 125 feet for the loss 
calculation will not affect the final answer very much, but the ratio of physical length to 
the velocity factor is important (as mentioned above).  

The nominal impedance, Zo, of the coax is very important. This can be found from the 
manufacturer’s data sheet.  It does vary from one manufacturing run to another and it 
varies somewhat along the roll of coax. This value may be fine tuned by using a known 
terminating resistance of a few hundred ohms to experimentally optimize the transformed 
value. After the cable is characterized by testing the actual cable or an equivalent piece of 
cable (ideally from the same roll), the transformed impedance values will be accurate to 
within a few percent. 
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                                             Line Extension 

When an adapter is used to connect a line to the AIM4170, there will be some shift in the 
displayed parameters due to the phase shift in the adapter.  This can be compensated by 
doing the regular analyzer calibration with the adapter in place. Alternatively, it can be 
compensated by treating the adapter as an extension of the transmission line and 
reversing the phase shift.  The extension is assumed to be a short piece of ideal coax (no 
loss) with a specified length, characteristic impedance (Zo) and velocity factor.  There is 
no limit to the length, but typically the extension will be short. The default unit of length 
is centimeters. The length can be entered in inches, feet, or meters by following the 
number with an “i”, “f” or “m” (upper or lower case letters can be used).  

The length can be positive or negative. Enter zero to turn the extension function off. 
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This graph shows the effect of inserting an adapter in series with a piece of RG59/U coax 
that is terminated with a 200 ohm resistor.  

A- The first trace for the phase crosses the frequency axis at about 58.8 MHz.  

B- When the adapter, which is about 6.5 cm long is inserted, the phase plot crosses at 
about 56.5 MHz since the line appears to be longer now and the frequency 
corresponding to a half wavelength is lower.   

C- Enabling the line extension function with length=6.5 cm, Zo=50, and Velocity 
Factor=1 compensates for the extension and the last trace coincides with the first 
trace that was made without the extension.  

Note the value for Zo corresponds to the adapter, not to the transmission line.  
Depending on the construction of the adapter, it may take some experimentation to find 
the equivalent length. Only the electrical length, not the physical length, is important for 
this function, so the velocity factor can be left at 1.0 unless its value is known.  The 
compensation only depends on the product of Length*Velocity_Factor.  
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                     AIM4170 Principles of Operation 

      The AIM4170 is based on the same technology used in the AIM430 and AIM4160. 
1. An RF voltage is applied to the transmission line input.  

To reduce the chance for interference to nearby radio receivers, the maximum 
output power is less than 20 microwatts (-17 dBm). 
 

2. Measure the applied voltage and the current flowing into the load. The current is 
measured across a precision resistor which has a much wider bandwidth than a 
transformer.  (The AIM4170 does not use any RF transformers). The current 
sensing resistor does not have to be adjusted and it has excellent long-term 
stability.  
 
 

 
 

3. Calculate the magnitude and phase of the input impedance.  The magnitudes and 
phases of the applied voltage and resultant current are measured with an analog to 
digital converter (12-bit ADC) and their ratio determines the magnitude of the 
impedance.  The sign of the phase is also measured so that capacitive and 
inductive reactances can be distinguished.  
 

4. The signal processing circuits are linear, so the nonlinearity problem inherent with 
diode detectors is eliminated. 
 

5. Calculate various parameters including: SWR, equivalent input resistance and 
reactance, cable length, cable loss.  A large number of parameters can be 
calculated using the fundamental impedance measurement.  The load is assumed 
to be an antenna but the data is displayed in such a way that discrete capacitors 
and inductors can be measured too.  These values are plotted versus frequency 
and the exact numeric data can be read by moving a cursor to the point of interest. 
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 Block diagram of the AIM4170: 
 

 
 

The AIM4170 uses two Direct Digital Synthesizer (DDS) chips. One generates the test 
signal and the other acts as a local oscillator to heterodyne the RF signals to the audio 
range. You can read about the basic principles of the DDS at this address: 
http://www.analog.com/library/analogDialogue/archives/38-08/dds.pdf  
 
A 20 MHz crystal controlled oscillator drives both of the DDS chips.  Inside the DDS, the 
clock is multiplied by a factor of 20, so the effective clock rate is 400 MHz.  Program 
frequency resolution is a fraction of a Hertz. The output of each DDS goes to a 170 MHz 
low pass filter to remove the harmonics of the digitally generated signal. The output of 
the low pass filter is a sine wave in the range of 0.1 MHz to 170 MHz.  Any amplitude 
variations or phase shift in the low pass filters do not affect the measurement accuracy 
since they affect the current and the voltage channels equally and thus cancel out when 
the ratio is taken. 
 
The output of one DDS supplies the test voltage and current to the load impedance and 
the other DDS acts as the local oscillator to heterodyne the voltage and current signals 
down to 1kHz.  Audio amplifiers boost the 1kHz signals and drive the input to the 12-bit 
analog to digital converter (ADC) that is inside the MSP430 microprocessor. This 
microprocessor is mounted inside the AIM4170 case. The raw data is sent from the 
microprocessor to the external PC via the RS232 port.  The PC calculates the various data 
values and displays them graphically. 
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Reflection Coefficient:  
 
To find the SWR (standing wave ratio) of an antenna, we first calculate the reflection 
coefficient. This is the ratio of the voltage that is reflected at the antenna to the voltage 
that arrives at the antenna from the transmitter. If all the power from the transmitter is 
radiated into space, there is no reflection, the reflection coefficient is zero and the 
SWR=1.0.   
 
The following discussion uses the concept of complex numbers. A tutorial on complex 
numbers is available in Appendix 1. 
 
Reflection_Coefficient = Rho = ( Zload – Zo ) / ( Zload + Zo ) 
 
Zload = antenna impedance 
Zo      = transmission line impedance 
 
Note that in general, Zload and Zo are complex numbers of the form:  
 
Zload = Ra + jXa   and   
Zo=Ro+jXo. 
 
Xo, which is the imaginary part of Zo, is often neglected since it is usually small 
compared to the real part, Ro.    
 
Since Zload is a complex number, the reflection coefficient, Rho, is also a complex 
number. 
  
The reflection of the incoming power from the transmitter is caused by a mismatch 
between the transmission line impedance (Zo) and the impedance of the antenna at 
the operating frequency.  For example, if the transmission line has an impedance of 50 
ohms and the antenna is a dipole with an impedance of around 75 ohms, there is a 
mismatch and some of the power is reflected even though the antenna itself may be very 
good. If the transmission line is changed to 75 ohms, the match is much better, there is 
less reflection and the SWR is closer to 1.0. 
 
In the special case where the transmission line is open at the antenna (due to a broken 
wire), all of the power that arrives at this open circuit will be reflected back toward the 
transmitter and the reflection coefficient is 1.0 and the SWR= infinity.  Another 
interesting case is when the transmission line is shorted at the antenna terminals.  Again, 
all the power will be reflected (none is radiated) but the signal is inverted, so the 
reflection coefficient is now –1.0 (minus one). The magnitude is still unity (that is, +1) 
and the SWR=infinity. 
 
Thus, we see that the magnitude of the reflection coefficient will be in the range of zero 
to 1.0 for any combination of transmission line and antenna.   
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The reflection coefficient also has an associated phase angle, Theta, between the incident 
voltage from the transmitter and the reflected voltage. The real and imaginary parts of 
Rho can be related to its magnitude and phase angle with the following equations:   
Real_part_of_Rho          = rhoa = Magnitude_of_rho * COS(Theta) 

Imaginary_part_of_Rho = rhob = Magnitude_of_rho * SIN(Theta) 

Rho = rhoa + j rhob 
 
 
Standing Wave Ratio (SWR): 
 
SWR is the ratio of the Maximum Voltage to the Minimum Voltage along a transmission 
line.  On a perfectly matched line, the maximum is equal to the minimum since there is 
no variation in the voltage along the line and the SWR is 1.0.  In the real world, SWR is 
somewhere between 1.0 and infinity.  The special case of infinity means all the power 
from the transmitter is reflected back by the antenna. This would the case for a short 
circuit or an open circuit at the antenna when using a lossless transmission line. 
 
If the transmission line has no loss, the SWR is the same at all points along the line. That 
is, the SWR at the transmitter is the same as it is at the antenna.   As the transmission line 
loss increases, the effect is to make the SWR measured at the transmitter appear to go 
down since less power is received back from the antenna. This power gets lost along the 
transmission line, so it does not arrive at the SWR meter and the meter responds more to 
the outgoing power from the transmitter. The meter thinks the antenna is a better match 
than it really is because there seems to be less reflected power.    
 
The SWR only depends on the magnitude of the reflection coefficient, Rho: 
 
 SWR =  [ 1 + magnitude(Rho)] / [ 1 – magnitude(Rho)] 
 
This shows that when the magnitude of Rho = 0 (that is, the transmission line and the 
antenna are a perfect match), the SWR is [1+0]/[1-0] = 1 (this is the ideal case). 
 
When the mismatch is very large and the magnitude of Rho is nearly 1, the term in the 
denominator approaches zero and the SWR approaches infinity. 
 
Since only the magnitude of Rho appears in this equation, SWR is not a complex number 
(it’s a real number). 
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                 Measurement of Crystal Parameters 
 

Quartz crystals can be modeled as shown below: 

 

The series resonant frequency is the lower of the two frequencies. It’s determined by L 
and Cs. The higher parallel resonant frequency is determined by L and Cp+Cs.   

A broad scan can be done to locate the resonant frequencies. They will be displayed at 
the top of the screen. Typically, these two frequencies only differ by a few kilohertz. 

(The screen pictures in this section were taken using an AIM430. The same features are 
included in the AIM4170.) 
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                         Automatic Crystal Parameter Calculation 

The calculations to find the crystal 
parameters are tedious so they have been 
combined into a procedure than can be 
called from the Data menu.  First click 
“Measure Crystal”: 

 

Then enter the series resonant frequency.  

This should be within 100KHz of the series  
resonant frequency.  When measuring an 
overtone crystal, enter the appropriate 
harmonic frequency. 

 
 

After a few seconds the crystal parameters 
will be displayed.  A parameter to specify 
the number of readings to average for the 
parallel resonant frequency is in the config 
file. The default value is 32. 

The data can be saved in a file. If the file 
already exists, the data will be appended 
(added) to it. If the file does not exist, a 
new one will be created with the .xdat 
extension. 

This file is compatible with programs that 
read comma separated variables (*.csv) 
files, like Excel.  A legend is included to 
show the variable in each column. 
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The following discussion goes into more detail about the crystal calculations.   

After the resonant frequencies are located, you can change the scan limits to focus in 
more detail on the region of interest. 

At the series resonant frequency, the reactances of L and Cs cancel out and the magnitude 
of the impedance becomes equal to R. Therefore, the series resistance of the crystal can 
be read directly at the minimum value of Zmag on the graph; the numeric value is Rs in 
the Data Window.  

 

At frequencies well below the series resonant point, the impedance value is the total 
capacitance, Ctotal, which is essentially equal to Cparallel.  Cparallel is read at a 
frequency equal to 78% of the series resonant frequency. 

          Ctotal approx = 4.5 pF    

The value of Cseries is given by: 

           Cseries = Ctotal * 2 * (Freq_parallel  - Freq_series ) / Freq_parallel 

Where Freq_parallel is the parallel resonant frequency and Freq_series is the series 
resonant frequency. 
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           Cseries = 4.5pF * 2 *(12.12059 – 12.09557)/12.12059 = 0.0186pF 

The inductance L is given by: 

         L = 1 / ( 4 * pi*pi * Freq_series * Freq_series * Cs ) 

         L = 1/(4*pi*pi*12.09557MHz^2*0.0185pf)  = 9308 uH 

The Q of the crystal is found by measuring the two frequencies F1 and F2 on either side 
of the Freq_series where the phase angle is +/- 45 degrees.    

         Q = Freq_series / ( F2 - F1 ) 

         Q = 12.09585/(12.09591 – 12.09578) = 93045 
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Frequency Source 
 
When the AIM4170 is used  as a signal source, DO NOT connect it directly to the 
antenna connector of a transceiver. If the transmitter is accidentally turned on, the output 
will exceed the maximum input level to the AIM4170. 
  
The AIM4170 can be used as a signal source for testing electronic circuits, such as radio 
receivers.  The programmed frequency has a nominal accuracy of +/-30ppm and it can be 
calibrated with respect to WWV at 10MHz.  The amplitude of the output is not regulated 
by an AGC circuit but it is flat within 1 db across any amateur band.   
 
The flatness can be improved by terminating the output of the AIM4170 with a 90 ohm 
resistor before connecting the 50 ohm coax to the circuit under test. If the interconnecting 
cable is 75 ohms, the AIM4170 terminating resistor should be 225 ohms.  If flatness is 
not important, the coax can be connected directly to the AIM4170.    
 
The nominal signal delivered to a 50-ohm load is about 30mV rms. If  an extra 90 ohm 
terminating resistor is used, the signal level will be about 7mV rms across 50 ohms. 
 
Enter a frequency value in the text window and click “Enter”. The frequency can then be 
incremented or decremented by clicking the +/- buttons. 
 
To calibrate the frequency to WWV, tune in WWV at 10MHz and adjust the AIM4170 
output to zero beat with it. Then click the “cal” button shown in the dialog box below. 
This will apply a correction to all frequencies that are programmed later. The correction 
is also saved in the .ini file and automatically recalled each time the program starts up. 
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             Appendix 1 – AIM4170 Specifications 

Frequency Control:  Digital Synthesizer 0.1 - 170 MHz ; Stability: +/- 30 ppm 

Frequency Step Size:  1 Hz to 10MHz 

Calibration: software controlled (no screwdriver adjustments). 

ADC resolution: 12 bits. 

Measurement Ranges: 

SWR: 1 to 20 

Impedance:  1 ohm to 2K ohms 

Accuracy:  1 ohm +/- 5% of reading up to 60 MHz  
                  10% of reading up to 170 MHz 

Phase Angle: +/-90 degrees (true phase) 

Parameters displayed include: SWR, Reflection coefficient, Return loss, Magnitude of load 
impedance, Phase angle of load impedance, Equivalent series resistance and reactance, 
Equivalent parallel resistance and reactance. Reactance is shown as inductance (uH) or 
capacitance (pF) according to the phase angle.  

Smith Chart display. 

Data can be referenced to the antenna terminals. 

RF Output: 20 microwatts max; BNC connector (UHF female adapter included) 

Spurious output:  –30dBc or better 

Max stray RF input while measuring: 150mV peak  (-6dBm)  

Max safe RF input: 2V peak (+16dBm)  

PC Interface: RS232. Data rate = 57.6K or 115K baud. An optional USB/RS232 adapter is 
available when ordering the AIM4170. 

Display: Graphics output on PC screen.  Mouse controlled cursor for digital parametric readout. 
Morse code output for selected parameters.  An audible tone related to SWR can be output to 
assist in making adjustment without watching the PC monitor.  

Power Requirements:  6 to 15 VDC at 250mA max (120VAC power supply included) 

Dimensions (approx):  5” x 4” x 1.5”  (12.7 x 10.2 x 3.8 cm) 

Software for the analyzer hardware controller and the PC data analysis is upgradeable in the 
field.  Free software updates are available from  W5BIG.com.  
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                         Appendix 2 – Complex Numbers 
A complex number has two parts: a real part that we are accustomed to using for most 
everyday problems, and an imaginary part.  The imaginary part was introduced to handle 
the square root of negative numbers.  In ordinary circumstances, any number squared is 
positive, so it seemed unreasonable for a negative number to have a square root. This was 
resolved by defining a special value called “the square root of minus one”.  This is 
usually symbolized by “i” in math books and by “j ” in engineering books.  Using “j” 
avoids confusion in an engineering context with the symbol “i” that is usually used for 
current.   
 
Complex numbers came into use about 500 years ago for solving algebraic equations, 
including the familiar second order equation: ax^2 + bx + c = 0. 
 
(note: the symbol x^2  means “the value of x squared”= x times x.) 
 
Let’s look at a specific example:  x^2 – x – 2 = 0. 
In this case the coefficients are:  a = 1,   b = -1,   c = -2 
 
The solutions using the quadratic equation are: 
 
  x = [ - b + SQRT( b*b – 4ac) ] / 2a 
 
and 
  
 x = [ - b - SQRT( b*b – 4ac) ] / 2a 
 
 
Inserting the coefficients of the equation, we get: 
 
x = [1 + SQRT(1 + 8)]/2 = 2 
 
and  
 
x = [1 – SQRT(1+8)]/2 = -1 
 
Now, if we go back and insert x = 2 into the equation, the equation is equal to zero and 
we also get zero by plugging in x = -1. 
 
There is no problem here since we didn’t have to worry about the square root of a 
negative number. 
 
A small change of one coefficient changes the mathematical problem considerably, as we 
will see now: 
 
Let the equation be:   x^2 – x + 2 = 0  
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a = 1,   b = -1,  c = +2 
 
Changing “c” from –2 to +2 gives us: 
 
x = [1 + SQRT(1 – 8)]/2  
 
 and 
 
x = [1 – SQRT(1-8)]/2  
 
Now we have to deal the problem of evaluating the square root of –7. 
 
We write this as:  -7 = (-1) * (+7) 
 
Note the SQRT(A*B) = SQRT(A)*SQRT(B), so SQRT(-7) = SQRT(-1)*SQRT(+7). 
 
The SQRT(+7) is 2.646 and SQRT(-1) we define as “j ”, so SQRT(-7)=j *2.646. 
 
One solution to the equation is: 
 
x = [ 1 + j2.646 ]/2 = 0.5 + j1.323 
 
To confirm that the value x=0.5+j1.323 actually does cause the equation to equal zero, 
we have to do some arithmetic with complex numbers.   
 
Addition  is straightforward: 
 
The real part of one number is added to the real part of the second number. 
Similarly, the imaginary part of one number is added to the imaginary part of the second 
number. 
 
  (a + jb) + (c + jd) = (a+c) +j(b+d) 
 
For example:   ( 1 + j4 ) + ( 5 + j8 ) = (5+1) +j(4+8) = 6 + j12 
 
Multiplication i s a little tricky: 
 
The two complex numbers have to be multiplied term by term: 
 
(a+jb)*(c+jd) = a*c + jb*c + a*jd + jd*jb   
 
We get 4 terms.  Note that j*j = -1, so the last term = -d*b  (this is a real number) 
 
The first and fourth terms are real, so we can add them directly to get: (a*c – d*b) 
 
The second and third terms are imaginary, so we can them to get:  j*(b*c + a*d) 
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The final result is:  
 
(a+jb)*(c+jd) = (ac – db) + j(bc + ad) 
 
This is tedious. Fortunately, the computer is good at this sort of thing, so we usually don’t 
have to worry about the details. 
 
Now we’ll finish checking our equation by plugging in one of the answers that we found: 
  
Let x = 0.5+j1.323 
 
x*x = (0.5+j1.323)*(0.5+j1.323) = - 1.50 + j1.323 
 
Then, the whole equation =  (-1.50+j1.323)  - (0.5+j1.323) –2 = 0   (good) 
 
To relate complex numbers to electrical circuits, we make the following observations: 
 
Resistance is a real number. 
 
Inductive reactance is a positive imaginary number. 
 
Capacitive reactance is a negative imaginary number. 
 
The impedance of a circuit is: 
 
Z = R + jX,    X = reactance and it can be positive (inductor) or negative (capacitor) 
 
For example, suppose we have a 100pF capacitor (100*10^-12 Farad) in series with a 500 
ohm resistor and the frequency is 7 MHz. 
 
At 7 MHz, the capacitive reactance X= -1/(2*pi*7000000*100*10^-12) = -227 ohms 
 
Note: the minus sign is very important. 
 
Z = 500 – j227 = impedance of the series R-C circuit. 
 
Real_part_of_Z  =  Re(Z) = 500 
Imaginary_part_of_Z  =  Im(Z) = -227 
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The magnitude of a complex number is the square root of the sum of the squares of the 
real part and the imaginary part: 
 
Magnitude_of_Z = SQRT( 500*500 + 227*227) = 549 ohms 
 
The phase angle, Theta, associated with this complex number can be calculated by: 
 
Theta = ArcTangent(Imaginary_part / Real_part) 
          = ArcTangent(-227/500) = - 24.4 degrees 
 
The negative angle is characteristic of a capacitive circuit. It means the voltage is trailing  
(or lagging) the current.  In an inductive circuit, the phase angle is positive since the 
voltage leads the current. 
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                      Appendix 3 – Hot Keys 

The following keyboard keys can be used instead of clicking buttons with the mouse: 

S – Scan (same as Scan button) 

R – Rescan (same as Rescan button) 

L – Enter new Limits (same as Limits button) 

D – Get raw data in Point Data mode (S, Z and T can be output in Morse code if desired). 

U – Do a scan and save the data in a file named $AutoScan$.csv for off-line processing       
by a program such as Excel. 

Q – Exit the program  

Left Arrow – Move the cursor to the left on the graph. 

Right Arrow – Move the cursor to the right on the graph. 

Up or Down Arrow – Swap the last two scans. (either key can be used) 

Left mouse button – disable the cursor movement (reverse this action with a flag in 
config file.) 
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                                Appendix 4 – RS232/USB Operation  

Because some newer computers don’t have RS232 ports, it may be necessary to use an 
RS232 to USB adapter with the AIM4170.  The AIM’s RS232 port uses only three wires. 
Pin 2 is the data from the AIM to the computer, pin 3 is the data from the computer to the 
AIM and pin 5 is ground.  Hardware handshaking is not used.  The signal amplitude on 
the I/O lines (pins 2 and 3) is approximately +/-5V. 

If the comm port assigned to the USB adapter is not known, try using the “Find Comm 
Port” command under the “Setup” menu. This will scan from comm 1 to comm 64 to find 
which port is working.  The comm port assigned to the USB adapter can also be found 
using the Windows Device Manager: Click Start �  Settings � Control panel �  System 
�  Hardware �  Device Manager. 

If there seems to be a problem with the USB adapter, here are some tips for checking it. 

First, make sure another accessory in the computer or another program is not tying up the 
comm port.  For example, if the AIM program is started two times without closing it the 
first time, the second copy cannot use the comm port. This can happen when the first 
AIM window gets hidden behind another window so it’s not obvious that it is still active. 

When the AIM first powers up, it sends out a character string that can be received by any 
terminal emulation program, such as HyperTerminal .  To use HyperTerminal, which 
is a standard accessory in Windows, click on the Start button in the lower left corner of 
the Windows desktop. Then, click “Programs” -> “Accessories” -> “Communications”  -
> “HyperTerminal”.  Set HyperTerminal for the following parameters: 

 Baud rate=57600; 8 data bits; 1 stop bit; no parity;  echo typed characters locally. 

When HyperTerminal is ready, turn on the AIM4170 power.  The green LED on the AIM 
front panel will turn on and the text displayed on the computer terminal is the following 
(or similar): 

Antenna Analyzer AIM4170 
from Array Solutions  
  Oct 13, 2006 
 
If this is displayed, it means the data from the AIM to the computer is okay.  If the text is 
not displayed, a scope or logic probe can be used to check for pulse activity on pin 2 of 
the RS232 connector with the PC cable disconnected. Pin 5 of this connector is the 
Ground pin.  The normal voltage at pin 2 is about –5V and it pulses to about +5V several 
times during a 1 second interval while the text string is output right after the power is 
turned on.  The PC doesn't have to be present at all, so this output test is completely 
independent of the PC or the operating system.  
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To check data from the computer to the AIM, type K1 (K and a one).  Note the K  is 
upper case. The command K1 will cause the AIM to turn on its Red LED.  There is no 
character space between the K  followed by a 1, but the time interval between typing the 
K  and the 1 is not critical.  Then, type K0 (K followed by a zero). The Red LED should 
go off.  This indicates the AIM is able to receive commands from the computer; 
therefore, the I/O data link is working properly. 

It has been found that sometimes the computer operating system will say the USB driver 
is properly installed when it really isn’t.  Deleting the driver and then starting over and 
insisting that the driver be reloaded from the CD may work.    

A problem has also been found where Windows does not properly keep track of which 
comm port is in use. Some problems with the comm port can be solved by removing the 
port numbers that have been assigned in the past but which are no longer in use. This link 
has information for cleaning up the port assignments.  
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                            Appendix 5 – Scan Data File Format 

The scan data can be saved in two different formats that are suitable for importing into 
spreadsheets or plotting programs. 
In one file with the extension “.csv”, only the basic data is saved in the following order: 
 
Frequency in MHz, SWR, Rseries, Xseries, Zmag, Theta(deg), Reflection coefficient, 
Return loss(dB), Percent reflected power. 
 
The data values for one frequency are all on one line and are comma delimited.   
This file can be easily imported into a spreadsheet for detailed analysis.   

Another file with the extension “.scn” is saved with more information about the 
conditions of the scan.  A detailed example is show below. 
 
// The comments are not included in the actual file . 
// Parameters included in this file:  SWR, Rseries,  Xseries, 
// Zmagnitude, Theta 
// 
// If the equivalent parallel load circuit is neede d: 
//  Rparallel=Zmag*Zmag/Rseries 
//  Xparallel=Zmag*Zmag/Xseries 
// 
09-08-05  10:57:33    // first line, date and time of the scan 
 110                  // program version (changes i f the data format             
                      // changes) 
 20                   // number of data points minu s 1 : 
                      // (there are 21 data blocks below) 
 12                   // scan start frequency (MHz)  
 22                   // scan end frequency 
 0.500000000000000    // step frequency between tes t points 
 12                   // freq at left side of graph  plot (MHz) 
 22                   // freq at right side of grap h plot (may not be 
                      // the same as "scan end freq "  
 10                   // swr full scale 
 1000                 // z magnitude full scale 
 100                  // theta full scale (degrees)   
 22.500000000000000   // not used 
 0                    // not used 
 0                    // not used 
 0.500000000000000    // freq spacing between major  vertical lines on 
graph  
 1                    // plot_swr flag (1=true) 
 “comment string”     // graph comment string, if a ny.  
1010.010620117187500  // SWR :  Start of data block s; 5 items per block  
                      // repeated 21 times in this example 
 0.892523407936096    // Rseries : equivalent serie s resistance of load 
 206.328903198242190  // Xseries : equivalent serie s reactance of load 
 206.330841064453120  // Zmagnitude : magnitude of load impedance 
 1.566470623016357    // Theta : angle of load impe dance, radians 
 440.064605712890620  // next SWR 
 2.952029705047607    // next Rseries, etc 
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 249.890869140625000 
 249.908309936523440 
 1.558983564376831 
 284.346221923828120  // SWR 
 7.125505924224854 
 314.254211425781250 
 314.334991455078120 
 1.548125863075256 
 202.912612916039060  // SWR 
 17.597200393676758 
 419.200958251953120 
 419.570159912109370 
 1.528843045234680 
 158.592254638671870 
 49.341548919677734 
 621.562377929687500 
 623.517761230468750 
 1.491579294204712 
 134.716033935546880 
 205.956863403320310 
 1158.638305664062500 
 1176.801147460937500 
 1.394876122474670 
 123.570953369140620 
 4566.038085937500000 
 2713.321289062500000 
 5311.385742187500000 
 0.536173224449158 
 114.446578979492190 
 421.559051513671870 
 -1494.078613281250000 
 1552.411987304687500 
 -1.295792102813721 
 108.322395324707030 
 105.496887207031250 
 -746.862121582031250 
 754.276245117187500 
 -1.430471181869507 
 102.702613830566410 
 49.549240112304688 
 -499.510437011718750 
 501.961944580078120 
 -1.471924185752869 
 97.688926696777344 
 29.741893768310547 
 -376.700836181640620 
 377.873107910156250 
 -1.492006182670593 
 91.975608825683594 
 20.779895782470703 
 -304.370910644531250 
 305.079406738281250 
 -1.502630472183228 
 88.663787841796875 
 15.381784439086914 
 -255.856430053710940 
 256.318389892578120 
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 -1.510749816894531 
 80.219047546386719 
 12.850700378417969 
 -221.102661132812500 
 221.475799560546870 
 -1.512740731239319 
 76.584655761718750 
 10.647170066833496 
 -195.356231689453120 
 195.646148681640620 
 -1.516348838806152 
 68.956077575683594 
 9.652303695678711 
 -175.194458007812500 
 175.460159301757810 
 -1.515757203102112 
 65.095878601074219 
 8.543374061584473 
 -158.872634887695310 
 159.102188110351560 
 -1.517073035240173 
 61.215835571289063 
 7.745326042175293 
 -145.441238403320310 
 145.647323608398440 
 -1.517592549324036 
 58.022541046142578 
 7.089697837829590 
 -134.253402709960940 
 134.440475463867190 
 -1.518036961555481 
 53.652206420898437 
 6.746065139770508 
 -124.731056213378910 
 124.913352966308590 
 -1.516764044761658 
 50.906970977783203     // last SWR (21 data blocks  in all) 
 6.325359821319580      // last Rseries 
 -116.475082397460940   // last Xseries 
 116.646713256835940    // last Zmagnitude 
 -1.516543030738831     // last theta 
 50                     // real part of transmissio n line 
                        //impedance (ohms) 
 0                      // imaginary part of transm ission line 
                        // impedance 
 0                      // transmission line type 
 0.660000026226044      // transmission line veloci ty factor                           
 0                      // cable length 
 1                      // meters or feet scale fac tor 
 1                      // plot Xseries flag  
 1                      // plot Rseries flag 
 0.000000045816051      // Next five values are cal ibration data, not            
                        // needed by spreadsheet 
 0.000000000007380 
 -0.025273719802499 
 1.023359417915344 
 100.599998474121090    // last line 
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               Appendix 6 - Battery Operation  

The AIM4170 can be powered with a battery for portable operation.  Battery voltage can 
range from 6.0 to 15V. The required current is 250mA when a measurement is in process 
and 50mA when idle.  The power is turned off automatically after 10 minutes of 
inactivity when the Auto-Power-Off feature is enabled (this is an option in the SETUP 
menu at the top of the screen).  

Suitable batteries include a conventional 9V battery or a 12V car battery. The easiest way 
to connect the battery is to use a barrel connector like the wall power supply uses. This is 
a 5.5x2.1mm barrel connector. The Mouser part number is: 1710-2120. 

Alternatively, the battery can be installed inside the AIM4170. There are diodes on the 
card to automatically select either the wall power supply or the internal battery. The 
power on/off switch will disconnect the battery too, so the off-state current drain is only 
about 1 microamp.     

Refer to the Applications file under the Help menu for more information on battery 
operation.  

 

J6 is the power connector mounted on the 
rear panel. The wall power supply (or 
external battery) plugs in here. D1 and D11 
are a cross-over circuit to select either the 
external or internal power source, 
whichever is more positive. The battery 
positive and negative connections are 
labeled on the pc board.  

R54 is an optional resistor for trickle-
charging a rechargeable battery. This is a 
user-selected resistor. It is not included in 
the AIM4170 but there is a space on the 
PCB for mounting a through-hole resistor.  

 



 PowerAIM 120                                                                                  page 59 

This photo shows how an optional battery 
or battery pack can be mounted inside the 
case.   

(An AIM4160 is shown here, but the 
AIM4170 is electrically the same. The 
battery can be mounted on the top cover of 
the AIM4170.) 

 

In the lower left corner of the board are 
shown the pos(+ RED)  and neg(- BLUE) 
battery connections.  

D1 and D11 are included on the PCB. 
There is an open space to install an 
optional R54 for charging a battery. 
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                         Appendix 7 – Saving Screen Shots 

Pictures of the scan can be very useful for documentation.   A nice freeware utility that 
makes this process easy is called “PrintScreen” from Gadwin: 
http://www.gadwin.com/printscreen/ 

This utility installs very easily. It can save the whole screen, the current window (the one 
with its top banner highlighted), or a rectangular area that you can select. For saving  
shots of the AIM data, the current window is probably the most useful choice. This 
should be saved in gif format, not jpg.  Gif format saves a better quality graphic image 
and it usually takes fewer bytes than jpg. (jpg is better for photographs.)  

You can save the screen in .bmp format by clicking:  File ->Save Image Bitmap  

If you don’t use PrintScreen,  you can save screen shots with a conventional paint 
program. The first step is to copy the screen image to the clipboard by pressing the ALT  
key and then the Print Screen key. This will transfer the active window to the clipboard.  
If you want to copy the entire screen, just press the Print Screen key. 

The screen image can now be inserted into a program, such as Microsoft Word , 
Paintshop or Paint Shop Pro by pressing Control-V .  

 The Windows operating system also includes a standard accessory program called 
“Paint” that’s available on all computers.  

 To run “Paint”, click the Start button in the lower left corner of the screen.  

Then click “Programs” 

Scroll to find “Accessories” 

Click “Paint” 

Click Control-V  to insert the screen shot into the working page. 

Then save the file as a .gif or .jpg. (.gif is preferable since the quality of the line drawing 
is better than .jpg) 

Now your screen shot can be inserted into a document file or attached to an email. 
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                            Appendix 8 – Configuration File 

The configuration file (*.cfg) is used to set the screen colors and some other display 
parameters.  A utility called colors.exe is included with the AIM software to aid in 
selecting screen colors. Move the sliders to get the desired color combination. Note the 
numeric values for red, green, and blue and then enter these values in the config file using 
a text editor.  Several different config files can be resident in the same folder. They are 
selected using the menu option: File -> Load Config File.  

The following comments are included in the config file itself. 
============================================================== 
This is a comment line that is displayed when the config file is loaded from the menu.  
// The user-supplied comment above will be displayed when the config is loaded from the 
// menu.   
// The comment line does not have to start with the // symbols. 
// There can be several config files in the same folder. The comment in the first line is 
// helpful to differentiate them. 
 
// April 23, 2006 
// AIM configuration file 
// The parameters must remain in the same sequence. 
// When new parameters are added, they will be placed at the end of the file. 
 
// Comments or blank lines can be inserted freely. 
// Comments are indicated by a double-slash // 
// The double-slash should start in column 1. 
// If the config file is not found in the same folder as the exe file, 
// default values will be used. 
 
// COLORS for PLOTTING: 
// Colors are entered as RED, GREEN, BLUE with values 0-255 
// 0=no color, 255=maximum color (max red, max green, or max blue) 
// Examples:  0,0,0 = black  (no red, no green, no blue) 
//                   255,255,255=white (max red, max green, max blue) 
//                  255,0,0=bright red     0,255,0=bright green     0,0,255=bright blue 
 
// The included utility file: colors.exe can be used to help select the colors. 
// The numbers should be in decimal format. 
// A space or comma can be used to separate the three numbers. 
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// Only the first number (or set of 3 numbers for colors) on each line is used. 
// The rest of the line is a comment. 
// A double-slash on a line means the whole line is a comment. 
 
// When experimenting with colors, the new set of colors can be entered on the same 
// line and the old ones are pushed to the right.  
// The old ones will be ignored by the program but they are handy for reference. 
 
// There are two sets of colors for each parameter: 
// The brighter color is used for the main scan (first scan) 
// A fainter shade of that color is used for the rescan (second scan) 
 
  240,0,0      RED=SWR (or reflection coefficient) main scan and Smith Chart trace 
  240,120,0  light red=SWR (or reflection coefficient) rescan 
 
  0,200,0          Green=Zmagnitude main scan 
  130,240,180  light green=Zmagnitude rescan 
 
  200,0,200      Magenta=Theta main scan 
  200,180,240  light magenta=Theta rescan 
 
  0,200,200    Cyan=vertical cursor that is moved with the mouse. 
 
  64,122,252    Blue=Return Loss main scan 
  160,160,250  light blue=Return Loss rescan 
 
  200,200,0    Yellow=Xs or Xp (whichever is selected) main scan 
  255,255,0    light yellow=Xs or Xp rescan 
 
  255,174,0      Orange=Rs or Rp main scan 
  255,195,125  light orange=Rs or Rp rescan 
 
  250,250,200    smbackground=Smith Chart background color 
 
  230,230,230  grid color=color of gridlines on the graph 
   
  200, 0,  0   file name color (cal,config,cable_cal file names displayed on screen) 
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// Cursor enable: 
    1 = (default) cursor is enable whether left mouse button is pressed or not. 
//     ( 0 means cursor is enabled only when left mouse button is pressed. ) 
 
// Graph line width: 
    2 = Line width of the plotted data (can be 1,2,3,4,5) 
 
// Halt: 
    2 =  Halt if right mouse button is pressed ) 
//       ( 0 = Halt if Halt button at bottom of screen is clicked )          
// 
//  BAND SELECTION:   Start_freq, Stop_freq, Step_freq (all in MHz) 
//  The actual "Stop_freq" on the graph will be equal to or greater than the 
//  value specified here. 
//  The frequencies specified DO NOT have to correspond to ham radio bands. 
//  The frequencies and the step freq can be any value within the range of the AIM. 
 
// Example of defining a band for an AM radio station: 
//           0.520,  0.620, 0.001,  station=KLIF_570   
// The string after "station=" is a user supplied string to identify the band 
// on the menu. It can be up to 12 characters long but it cannot have any spaces. 
// Use an underline or a dash character instead of a space. 
 
    1.7,     2.1, 0.01  // 160 meters  all of these values can be user specified. 
    3.4,     4.1, 0.02  //  80 meters 
    6.9,     7.4, 0.01  //  40 meters 
    13.9,   14.5, 0.01  //  20 meters 
    20.9,   21.6, 0.01  //  15 meters 
    27.9,   29.8, 0.05  //  10 meters 
    49.5,   54.5, 0.10  //   6 meters 
    143.5, 148.5, 0.10  //   2 meters 
 
    5.25,  4.25,  0.05  //  60 meters 
    10.0, 10.20,  0.005 //  30 meters 
    18.0, 18.20,  0.005 //  17 meters 
    24.7,  25.1,  0.01   //  12 meters 
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    1.00, 160.00, 2.0   //  Band A 
    1.00,  21.00, 0.2    //  Band B 
    5.00,  45.00, 0.25  //  Band C 
    13.00, 43.00, 0.2   //  Band D 
 
    240, 240, 240  // highlight color for bands 
    1000  max number of data points. This can range from 20 to 1000.     

0 meters/feet (1 means use meters as default length, 0 means use feet as default) 
 

    1000  Max delay in milliseconds for external hardware 

//     (for example, Bluetooth) to respond to the RS232 data link. 

//*************************************************************** 

// Parameters to set graph and font sizes: (new with version 600) 

// If the max width and height are larger than the actual screen size, 

                  // the full screen size will be used. 

// The earlier versions of the AIM program used a max graph size of 950 x 600. 

    950   max graph width in pixels  (original AIM graph width was 950 pixels) 

    600   max graph height in pixels (original AIM graph height was 600 pixels) 

    7  Default font size. 5 is very small, 6 and 7 are medium, 8 is large. 

//   minimum font value=3, maximum font value=10 
1 Bold Data display ( 0=not bold data ) 

//********************************************************************** 

0     Do not clear each screen during recycle mode ( 1= do clear ) 
300 Delay in milliseconds while recycling. Several seconds may be useful in some 

cases. 
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//**** versions 621 and higher: 

  1  parameter 1  future expansion 

  0        (1=issue cal warning if long stub is attached while calibrating) 

  2.0  parameter 3 

  0.1  parameter 4 

  32     averaging for crystal’s parallel resonant frequency measurement 

1   = don’t enable external program control,  
// 2=enable but don’t show counter 
//  3=enable external control and show counter. 

  1    auto save graph after each scan,     0=don't save 

// The next two lines are path names for the external control input and output files: 

// The names controlfile= and outputfile= must appear first on the line. 

// The exact position on the line is not critical. 

// The file and path names can be anything, they don't have to be on the C drive. 

// Don't enclose the path name in quotes. 

// Use double back-slashes for folder delimiters. 

// The path names CANNOT have spaces in them. Use dashes or underscores. 

// All valid filename characters are ok except spaces. 

 controlfile= C:\\temp\\datafile1.txt          input control file initiates scan 

 outputfile= C:\\temp\\$AutoScan$.csv    output data csv file 

  1    parameter 8  future expansion 

  1    parameter 9 
  1    parameter 10 
 
//  END of config file 
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                    Appendix 9 –  Component Test Fixture 
 
 
The AIM4170 can be used to measure 
small discrete components over a specified 
frequency range.  A convenient way to hold 
them is with a BNC to binding post 
adapter. Even though the adapter has 
significant stray capacitance and 
inductance, these stray parameters can be 
cancelled by the calibration procedure.  
The adapter shown here is from Jameco, 
part number 99354, which costs about 
$5.30 in the U.S.A. 
 (ref: www.jameco.com) 
 
When calibrating, insert a piece of wire 
between the binding posts for the short 
circuit . Then remove the wire for the open 
circuit . The resistor that is used can be 
any 1/4W or 1/8W carbon or metal film 
resistor with an accurately known value.  A 
resistor in the range of 50 to 500 ohms can 
be used. 

 

 
For testing very small surface mount 
components, another adapter can be made 
from a small piece of printed circuit board 
material. A cut down the middle isolates 
the two side.   A similar cut is also made on 
the back side if the printed circuit board has 
copper on both sides. Two heavy wires 
(#16 - #20) can be used to connect it to the 
binding posts. The chip component being 
tested can be held securely by pressing it 
against the board with the eraser of a pencil 
or a plastic screwdriver.  
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Here we see the surface mount adapter 
combined with the binding post adapter.  
The stray capacitance of this combination 
adapter will also be compensated by the 
calibration procedure.  Capacitors in the 
picofarad to nanofarad range and inductors 
in the nanohenry to microhenry range can 
be measured. 
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             Appendix 10 – External Program Control 

The AIM4170 can be integrated with a test system so that measurements are done under 
the control of a “master” program.  

AIM measurements will be triggered when the master creates a control file called: 
C:\Datafile1.txt (this name can be customized in the config file).  After the AIM scan is 
complete, it saves the data which has been completely processed by all the calibration 
and transformation procedures. 

The format for the control file  is: 

 1   Scan Trigger command  (line 1) 

 start_freq,  stop_freq,  delta_freq  ( 3 fixed point numbers in MHz) (line 2) 

 0   (not assigned yet) (line 3) 

 0   (not assigned yet) (line 4)  

If line 2 has zeros, the start, stop, delta values are not changed. The file must have at least 
four lines of text. If it has more lines, that’s okay, only the first four are read at this time. 
In the future other information may be included in the file. A sample control file called 
datafile1.txt is included with the program package so you can see the exact format with 
imbedded control characters.  This file was created using Notepad.  

 When the AIM program see this file, it reads the information, sets up the internal scan 
parameters for start, stop and delta, and does a scan.  Then it deletes the control file. 

The new scan data is saved in an output data file called C:\$AutoScan$.csv. This name 
can also be customized in the config file. 

 This is the same file format that is used now when the "Save Graph"  function is selected 
or the letter "U" is entered on the keyboard.  

 The external control feature is enabled by the “external program control” flag in the   
config file. 

The flag values are: 

 1 = no external control, normal operation 

 2 = enable control, no diagnostic display 

 3 = enable control, a counter appears in the upper left corner of the 

     screen to indicate the control routine is active.      
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 While the AIM is in the external control mode, the other features operate normally. It 
still responds to mouse and keyboard commands. 

 The external control scenario is:  

1. Turn on the AIM power and then start the AIM program. 

2. Change focus to the Master program. 

3. Master program deletes C:\$AutoScan$.csv (output data file) 

4. Master program creates C:\datafile1.txt  (control file) 

5. AIM does a scan with the specified scan limits. 

 6.   Master program waits until C:\$AutoScan$.csv (output data file) is created by the 
AIM. 

 7.   Master program processes the scan data. 

8. Loop back to step 3. 

To get a feel for how this works, you can create a control file with Notepad. As soon as 
the file is saved, the AIM will begin a scan. When the scan is completed, you’ll see the 
new *.csv file and the control file will have been deleted. 

Note: 

Similar results can be obtained by using a keyboard simulator program to send keyboard 
commands to the AIM4170 program. The letter “U” will cause the AIM to do a scan and 
save the $AutoScan$.csv file.  The letter “L” can be followed by numeric strings and tab 
characters to program the start, stop and step values. 
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                                     Appendix 11 – PowerAIM 
 
The PowerAIM normally operates with a 12V battery. The battery and a charger are 
included in the kit. An AC/DC converter that provides 12 volts at 500 ma or more can 
also be used.  The current required is about 500mA while a measurement is in progress 
and about 100mA when idle.   
   
Press the power switch. The Green LED will blink a few times to indicate the version of 
software and then remain on continuously. The Red LED is on only when a measurement 
is in progress. 
 
To turn off the power, press the power switch again.  If the PowerAIM does not receive a 
command from the PC for 10 minutes, it will power down automatically if it is in the 
AutoPwrOff  mode.  The default is to not power down automatically but if you’re using 
batteries, the AutoPwrOff mode can be turned on with a menu selection under Setup.  
 
Be sure the maximum input voltage at the DC power connector does not 
exceed 16 volts. The minimum input voltage required is 11.0 volts.  
 
 
NOTE:  Before connecting a transmission line to the input of the 
PowerAIM , be sure to momentarily short its pins together to drain off any 
static charge that may be present.  Also, be sure there is no DC voltage on 
the antenna. If there is DC, use a blocking capacitor between the AIM4170 
and the antenna input. 
 
Antennas and transmission lines can have enough static charge to damage sensitive 
electronic equipment. This can happen even when there is no rainstorm in the area. 
A strong wind can generate static charge. So can just flexing a coaxial cable by 
rolling it up or unrolling it, even if there is no antenna connected to it.   
 
An antenna or a component to be measured should not be connected or 
disconnected from the analyzer while a test is in progress.  A test is in progress when 
the RED LED is on.    
 
If the antenna under test may be picking up a strong external RF signal, 
check the voltage with an RF voltmeter first to make sure it does not 
exceed 25 volts peak (18 volts rms) with a 100 ohm load.  

When the PC program runs in demo mode it will default to the AIM4170. To enable a 
demonstration of the PowerAIM features, place a text file in the root directory with the 
following name:  C:\pa_120.txt 
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This file can be created with Notepad. It does not have to have any content, just the file 
name is used as a flag to enable the PowerAIM demo mode. The demo mode can be used 
to display and analyze scan files that have been saved previously. 

 

PowerAIM  Specifications 

Frequency Control:  Digital Synthesizer 0.1 - 120 MHz ; Stability: +/- 30 ppm 

Frequency Step Size:  1 Hz to 10MHz 

Calibration: software controlled (no screwdriver adjustments). 

ADC resolution: 12 bits. 

Measurement Ranges: 

SWR: 1 to 20 

Impedance:  1 ohm to 2K ohms 

Accuracy:  1 ohm +/- 5% of reading up to 60 MHz  
                  10% of reading up to 120 MHz 

Phase Angle: +/-90 degrees (true phase) 

Parameters displayed include: SWR, Reflection coefficient, Return loss, Magnitude of load 
impedance, Phase angle of load impedance, Equivalent series resistance and reactance, 
Equivalent parallel resistance and reactance. Reactance is shown as inductance (uH) or 
capacitance (pF) according to the phase angle.  

Two Smith Chart displays. One can be phase shifted with respect to the other. 

Data can be referenced to the antenna terminals. 

RF Output: 2 milliwatts max; type-N connector standard. 

Spurious output:  –30dBc or better 

Max stray RF input while measuring: 25V peak.  

Max safe RF input: 50V peak.  

PC Interface: RS232.  Data rate = 57.6K or 115K baud. An optional USB/RS232 adapter is 
available when ordering the PowerAIM . 

Display: Graphics output on PC screen.  Mouse controlled cursor for digital parametric readout. 
Morse code output for selected parameters.  Up to 20 markers for user specified frequencies. 

An audible tone related to SWR can be output to assist in making adjustment without watching 
the PC monitor.  
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Power Supply:  12 VDC at 500mA max (12V battery and 120VAC battery charger included) 

Battery power source can range from 11 to 16V. Required current is approximately 500mA when 
a measurement is in process, 100mA when idle.  Auto-power-off after 10 minutes of inactivity.  

Dimensions (approx):  5” x 4” x 2”  (12.7 x 10.2 x 5.1cm) 

Software for the analyzer hardware controller and the PC data analysis is upgradeable in the 
field.  Free software updates are available from  W5BIG.com.  The same program is used for the 
AIM4170 and the PowerAIM 120. 
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 Markers 

 
Markers can be defined to aid in collecting data at specific frequencies. Position the 
cursor near the desired point and right click . The marker frequency at the cursor appears 
in a dialog box. This value can be changed if desired.  A number followed by “k” or “K” 
is considered to be in kilohertz, otherwise, it is in megahertz. 
 

 
 
 
Click the Insert button to add a new marker or the Remove button to remove a marker. 
As markers are entered, they are displayed as red dotted lines, as shown below. 
The marker display can be turned on or off with the marker toggle function (see below). 
After a marker is inserted or deleted, the set of markers will be resorted in the order of 
ascending frequency. 
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Markers can be controlled using the menu item under the PowerAIM tab: 
Several options for the markers are shown in the submenu below: 
 

 
 
 
Display Marker Data – open a window to display all the presently defined markers and 
the data at these frequencies. The data is read when the window is opened. Click Refresh 
to take another set of readings. 
 

 
 
The column labeled SWR_Ratio shows the ratio of the SWR values at specified offsets 
from the center frequency.  The numbers in parentheses are the marker index numbers 
used for this ratio. For example, in this figure, the ratio on the top line is the ratio of the 
SWR values at markers 1 and 5. The ratio is always greater than or equal to one.  The 
markers do not have to be equally spaced. 
 
If the graph being displayed is from a scan that has been saved or processed by a DSP 
filter, the marker data will be taken from that data in memory and no new data is read 
from the hardware.  In this case, if some of the markers are outside the scan limits, a 
reminder will pop up indicating that data for some of the markers cannot be read.  Also, 
the refresh button will not be displayed. 
 
Theta Rotation – The marker data can be transformed to correspond to data that would 
be measured at the end of a transmission line with a specified electrical length or a 
network with a specified phase shift. 
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Toggle Markers -  turn the marker display on/off without changing them. 
 
Clear all Markers – removes all markers from memory. 
 
Save Markers – saves this set of markers to a user specified file. Any number of marker 
files can be saved.  These files have the extension *.mrk. 
 
When the marker data is saved using the SAVE button on the marker data window, a 
second file is also saved in a comma-separated-variables format (csv). This file as the 
same user specified name and the extension *.mrx . It can be input to a spreadsheet, such 
as, Excel.   
 
Recall Markers -  recall a set of markers from a file. 
 
Markers are also shown on the Smith charts: 
 

 
 
Additional functions on the PowerAIM tab: 
 
Check stray RF in – measure the peak stray signal appearing at the RF connector due to 
radio stations. This value is displayed in the lower right corner of the graph. 
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Typically this value is less than 1.0V. If it goes above 25 volts, the PowerAIM will not be 
able to make accurate readings in the presence of such a strong field.  This value is also 
checked automatically before each scan begins.  
 
If the stray RF input is more than 30V peak, the PowerAIM will not make a measurement 
since the input may be close to the damage threshold. If there is any doubt about the 
magnitude of the stray RF pickup, check the antenna with an RF voltmeter before                              
connecting the PowerAIM.   
 
 
Rotate Smith chart – enable the second Smith chart and specify the angle of rotation, if 
any.  The zoom factors for the two Smith charts can be different.   

 
 
 
SWR Ratio – measure the ratio of SWR readings at predefined 5KHz intervals from 
the center frequency. This is similar to the SWR ratio displayed in the marker data 
window. 
 
DSP filters 1 & 2 -  A distant station on the same channel may cause a small but 
noticeable disturbance of the scan where you want to make a measurement. This 
interference can often be eliminated by using the DSP filters. 
 
These filters have two parameters: center frequency & scan width.  The center 
frequency does not have to correspond exactly to the point where the noise is centered. 
Also, there can be more than one burst of noise in the scan range. Typically the scan 
range will be small, no more than 100KHz for signals in the AM broadcast band and up 
to 1MHz in the FM band.  The scan range is specified by its half-width . The scan will be 
between f1 and f2 corresponding to the center frequency minus the half-width and the 
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center frequency plus the half-width. The numbers can be entered in kilohertz by 
following them with a “K” or “k”. 
 

 
 
If 0.0 is entered for the center frequency, the DSP filter will process the data already in 
memory from a previous scan. This is useful for processing data saved in scan files. 
Otherwise, a new scan will be done with the specified scan limits and this new data will 
be processed.  
 
The two filters use different techniques and one may work better that the other, 
depending on the situation. The calculated data will be superimposed using a heavy line 
over the original data so you can see its effect.  The new trace can be displayed by itself 
by clicking on a function that causes the display to be refreshed, for example, click the 
scales button and then enter. 
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An example is shown below using DSP filter 1:  
 
ORIGINAL SCAN: 

 
 
AFTER PROCESSING WITH DSP FILTER 1:  
(heavy lines are new data after filtering)   
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In the example above, the heavy, highlight lines are shown so it’s easier to see the effect 
of the filter. Red corresponds to SWR, orange to Rseries and yellow to Xseries. 
 
Below are two screen shots showing the effect of using DSP filter 2. The interfering 
signal in this scan was injected using a transmitter feeding one antenna while the 
PowerAIM was scanning another nearby antenna. 
 
ORIGINAL SCAN: 
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AFTER PROCESSING WITH DSP FILTER 2:  

  
 
Save State – Save the present values of various parameters, including the scan limits, file 
names and markers. This is the same as the *.ini file but it has a unique name so these 
data can be recalled later for particular applications. 
 
Recall State – Recall a state that was previously saved. 
 
PowerAIM Help – a help file for the commands specific to the PowerAIM. This 
supplements the regular Help file under the Help tab. 
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                                   Terms and Conditions 

ORDERING: visit our on-line store at www.arraysolutions.com/pricelist.htm or phone 
us at (972) 203-2008 (9:00-4:00 CST) to order. More information on ordering is shown 
below. 

UPGRADES: Software upgrades are available at  no cost. This includes programs for 
both the analyzer controller and the PC.  

 
Check the website: w5big.com/prog_update.htm for the latest version of the program 
and the latest application information.  
 

 POLICIES AND WARRANTIES: 

Products Manufactured By Array Solutions - Limited Warranty 

Believe it or not we have a lifetime warranty on products we manufacture. We warrant 
the functioning of the product as designed.  If it fails to function as designed, we will 
repair or replace it free of charge as long as you, the original purchaser, own it and it was 
not damaged from lightning, other act of God or other casualty.  We reserve the right to 
make that determination.  We will photograph the evidence of such non-covered damage 
and will be happy to show it to you.  We will listen to any reasonable argument on your 
behalf to alter our opinion and do our best to reach a mutually agreeable solution.  You 
must pay for shipping charges both to and from us. 

 Procedure for Obtaining Warranty Service 

 If you have any doubts as to whether a problem is with our product or somewhere else in 
your system, please call us at our below listed telephone number.  No one else besides us 
is authorized to perform our warranty obligations.  If you are sure the problem is with our 
product, just ship it to our factory address.  Please follow the packaging procedure 
explained below under "ALL REPAIRS."  We will not make a warranty repair unless you 
include a copy of your purchase receipt, so please include it with the product to be 
repaired. 

 This warranty gives you specific legal rights, and you may also have other rights that 
vary from state to state. 

 Products Not Manufactured By Array Solutions - Manufacturer's Warranty Only 

 We do not warrant other products we sell.  They are warranted by the original 
manufacturer.  Please follow the manufacturer's policies and procedures for warranty 
service to insure the best and quickest service. 
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 Provisions Applicable to All Products 

Very Important, retain all shipping boxes for possible claims made to the shipper for 
damaged product!  Not doing so will affect how your warranty replacement is handled 
since we cannot replace a product that had it damage claim rejected due to the customer 
not retaining the original shipping box. 

 In no case will we be liable for any incidental or consequential damages, which includes, 
but is not limited to, damage to equipment connected or attached to any product we sell.  
Some states do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you. 

 Your sole and exclusive remedy upon our failure to meet our warranty obligations to 
repair or replace as described above is refund of the purchase price. 

 ANY CONTROVERSEY OR CLAIM ARISING OUT OF OR RELATING TO 
PRODUCTS WE SELL SHALL BE SETTLED BY ARBITRATION IN 
ACCORDANCE WITH THE  ARBITRATION RULES OF THE AMERICAN 
ARBITRATION ASSOCIATION.  

You may obtain warranty information at no charge by calling us at the below telephone 
number or by contacting the manufacturer for products we do not manufacture. 

OTHER THAN AS STATED ABOVE, ARRAY SOLUTIONS DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR 
PURPOSES WHATSOEVER AND ANY IMPLIED WARRANTIES. 

ALL REPAIRS:  When sending in a product for service, please carefully "double" box it 
and ship it insured for your protection.  Please include a note clearly describing the 
problem, how you wish the item returned to you and how you wish to pay for the service 
if it is not covered by our warranty.  Package your item properly.  Array Solutions is not 
responsible for merchandise damaged in shipment.  Our service rate is $50 per hour (2 hr. 
minimum). 

NON-REPAIR RETURNS:  Returned items must be received by us in original, as-
shipped, condition including the original box, manuals, accessories, and copy of sales 
receipt.  Returns must be within 14 days of purchase.  Returned items are subject to a 
15% restocking fee.  Shipping charges are not refundable.  

Phone and FAX:  

Tel: 972 203 2008 

 Fax: 972 203 8811 

 Factory Address: Array Solutions  350 Gloria Rd. Sunnyvale TX 75182 
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 Sales Outside the United States:  Purchase of products by those outside the United States 
of America constitutes purchaser's agreement that all questions concerning the respective 
rights and obligations arising under the terms of purchase are subject to arbitration under 
the provisions of Texas Civil Practice and Remedies Code Section 172.001 et seq. 

On Line: Ordered on line. Our secure, dedicated server is one of the fastest and protected 
with 128-bit encryption. You can be sure of your privacy.  

PAYMENT: We accept Visa, Mastercard,  money orders, cashiers checks and personal 
checks, and bank transfers. Phone order customers please be ready to provide card 
number, expiration, issuing bank, billing and shipping address plus home & work phone 
(e-mail customers please provide this information also). We request this information for 
your protection. Money orders, cashiers checks and personal checks may require 2 weeks 
to clear from un-established customers and/or large purchases.  

MINIMUM ORDER: We have no minimum. Your order is important to us whether it is 
for $5 or $500.  

SHIPPING of Array Solutions Stocked Products: We ship most orders within 5 business 
days (UPS Next Day and Second Day Air orders are shipped within 24 hours). We ship 
Monday through Friday. Our normal method of shipment is UPS Surface  International 
orders are sent with Air mail parcel post or EMS. We do not ship C.O.D. Array Solutions 
reserves the right at any time after receipt of your order to accept or decline your order 
for any reason. You may request shipment by other means such as FedEx, UPS Next Day 
Air, UPS Second Day Air or Air Freight for export orders. Equipment is packed very 
carefully and sent insured. Please provide us with a full shipping address. UPS cannot 
ship to a Post Office box.  

Shipping of ICE Products is usually shipped to you Factory Direct from ICE. ICE ship 
dates vary extensively due to customer demand and products in stock at their facility. We 
cannot be held liable for the ship date of their products, but we will try to expedite the 
order if we are told by you that you need it by a certain date. Please order these products 
early. 

PRICES: Prices and specifications are subject to change! We are not responsible for 
typographical errors.  

SALES TAX: Array Solutions shall automatically charge and withhold the applicable 
sales tax (8.25%) for orders to be delivered to addresses within the state of Texas. Each 
customer shall be solely responsible for all sales taxes, or other taxes, on orders shipped 
outside Texas.  

FOREIGN ORDERS: Foreign orders must be payable in U.S. dollars. You may use Visa, 
Mastercard, postal money order or bank check drawn on a U.S. bank with transit numbers 
imprinted on bottom of the check or bank transfer to our account. We will supply you our 
banking information upon request. The customer is responsible for shipping on warranty 
service. We do our best to deliver to you using the more expensive EMS (Express Mail 
Service) parcel post which allows us a tracking number to follow up if there is a problem. 
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We have experienced some long deliveries to certain countries like Spain, Portugal, Italy 
and some South American countries. We may insist on using a shipping service such as 
UPS, DHL, FEDEX, or Freight Forwarder for certain countries or large orders due to past 
losses in your country.  

SHIPPING TO Array Solutions: When you ship your equipment for service it is 
important that it is packaged properly. Use the original box and packing material if 
possible. If you do not have the original box, wrap the equipment well with bubble wrap 
then place this in a box with adequate packing material. All equipment should then be 
placed in a second box with packing material to help ensure its safe arrival to us. Please 
be sure to insure your package for its value. Array Solutions will not be responsible for 
equipment that is damaged in shipment to us.  

CUSTOMER INFORMATION: Array Solutions does not sell, rent, lease or trade 
customer information with any other company.  

LIMITATIONS OF LIABILITY: Except as expressly stated herein, Array Solutions. 
makes no representations or warranties, either express or implied, of any kind with 
respect to products sold on the Array Solutions website, including but not limited to, 
merchantability and fitness for a particular purpose. You agree that the sole and exclusive 
maximum liability that Array Solutions has arising from any product sold on the Array 
Solutions web site shall be the price of the product ordered. In no event shall Array 
Solutions, its directors, officers, employees or other representatives be held liable for 
special, indirect, consequential, or punitive damages related to products sold.  

RETURNS: Returned items must be received in the original condition including the 
program CD, power supply, cable, and accessory connectors. Returns must be within 
fourteen days of receipt.  If the original box is not available, suitable boxes can be 
obtained from the post office without charge. Use the original packing materials if 
available or the equivalent. For maximum protection of your equipment, insure the 
package and request a signature when it is received.  Shipping cost is not refundable. We 
will pay the return shipping for warranty repairs. 

WARRANTY SERVICE: Products have a one year limited warranty. This includes parts 
and labor. We will repair or replace the unit at our discretion. 

 

CIRCUITS AND PROCEDURES used by this vector impedance 
measurement system are covered by one or more patents pending. 

 

 


